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Novell Client Documentation

This documentation includes information on installing and configuring 
Novell® ClientTM for Windows* NT/2000 version 4.81 and later and Novell 
Client for Windows 95/98 version 3.31 and later software.

If you are using a previous version of Novell Client software, you should 
update it to the latest version (http://www.novell.com/download). If you are 
using a previous version of Novell Client software, some of the information in 
this documentation may not apply.

This documentation includes the following information:

Chapter 1, “Installing Novell Clients,” on page 13

Chapter 2, “Setting Up Client Login,” on page 27

Chapter 3, “Setting Client Properties,” on page 39

Chapter 4, “Managing Novell Client,” on page 43

Chapter 5, “Printing to a Network Printer,” on page 51

Appendix A, “Login Script Commands and Variables,” on page 57

Appendix B, “Sample Login Scripts,” on page 91

Appendix C, “Troubleshooting Issues,” on page 95

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions 
within a step and items in a cross-reference path.

Also, a trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk 
(*) denotes a third-party trademark.
Novell Client Documentation 11
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1 Installing Novell Clients

This chapter explains how to install Novell® ClientTM for Windows* NT/2000 
and Novell Client for Windows 95/98 software, on one workstation or across 
the network. It describes the following tasks:

Preparing to Install the Client Software (page 13)

Installing Novell Client at the Workstation (page 17)

Installing Clients from the Network (page 19)

Upgrading a Client Workstation to Windows 2000 (page 26)

Preparing to Install the Client Software

Before installing the client software, make sure the server and workstations 
have sufficient resources and the required software. The hardware and 
software setup for the server and client workstations require you to complete 
the following tasks:

Checking server protocols and requirements

Locating the latest Novell Client software

Checking for a valid network connection

Checking client workstation requirements

Checking Server Protocols and Requirements

You must prepare your servers to work with the Novell Client software. You 
must know what protocols you use on the server and make sure that the servers 
are configured to support long filenames. NetWare® 5 automatically supports 
Installing Novell Clients 13
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long filenames and does not need to have the name space added to it. However, 
you must add long filename support to NetWare 3.x and NetWare 4.x servers.

You can install Novell Client with one of the following protocol options:

IP Only (NetWare 5 or later)

Installs the IP protocol stack, which allows the client to run in IP-only 
networks; the workstation cannot communicate with IPXTM servers.

IP with IPX Compatibility Mode (NetWare 5 or later)

Installs IP and includes Compatibility mode, which allows IPX 
applications to run in IP-only networks by converting IPX packets into IP 
packets. IPX Compatibility mode allows the client to communicate with 
services in IPX-only networks if the Migration Agent is installed on any 
NetWare 5 or later servers. IPX Compatibility mode requires Service 
Location Protocol (SLP) on the server.

WARNING: Workstations using IPX Compatibility Mode cannot have an IPX 
internal network number configured. If you have configured an IPX internal 
network number on your workstation and you are planning to install the Novell IP 
Client with IPX Compatibility Mode, then remove the IPX internal network number 
before installing the client.

IP and IPX (default for new installations)

Allows the client to run in both IP and IPX networks. The workstation 
uses the same protocol as the server it is communicating with.

IPX Only

Allows the client to run in IPX-only networks. This option does not install 
IP.

NOTE: If you are upgrading Novell Client software and you are keeping the same 
protocol option, you do not need to select a protocol option. The previous protocol 
configuration remains unchanged unless you choose a different protocol.

NOTE: Novell recommends the Typical Installation option for most customers 
installing Novell Client. If you are installing Novell Client and you choose Custom 
Installation, note that the Novell IP Gateway is not compatible with NetWare IP or 
CMD (IPX Compatibility Mode Driver).

Adding Long Name Space

Make sure that long filename support is installed on NetWare 3.x or 
NetWare 4.x servers. NetWare 5 or later servers automatically support long 
filenames.
14 Novell Client for Windows
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IMPORTANT: Each name space added to a volume requires additional server 
memory. If you add name space support to a volume on a server without sufficient 
memory, that volume cannot be mounted. Once a name space is added to a 
volume, the name space can be removed from the volume only by deleting the 
volume and re-creating it, or by using VREPAIR.

1 Load the long name space.

At the server console prompt, enter

LOAD LONG.NAM

NOTE: On versions of NetWare prior to NetWare 4.11, use the OS/2* name space, 
OS2.NAM. For NetWare 3.11 servers, use OS2OPNFX.NML for long filenames. 
This NLMTM is a part of 311PTD.EXE and is available on the Novell Web site.

2 Add the long name space.

At the server console prompt, enter

ADD NAME SPACE LONG TO VOLUME volume_name

Downloading the Latest Client Software

Novell Client software is shipped on CD and is also available from the Novell 
Web site. You should install the latest version of the software. To download 
the latest Novell Client software, complete the following steps.

1 Create an installation directory.

2 At the Novell Web site (http://www.novell.com/download), click the 
client software that you want to download.

3 Follow the download instructions provided with the files on the Web site.

Checking for a Valid Network Connection

To check for a valid network connection from a Windows 95/98, Windows 
NT* or Windows 2000 workstation:

1 Open Network Neighborhood.

2 Make sure that the networks you expect to see actually appear in the 
Network Neighborhood window.

NOTE: If you have never installed a client or created a network connection, you 
might not have access to Network Neighborhood. Therefore, you must install the 
client software from CD-ROM. See “Installing Novell Client at the Workstation” on 
page 17.
Installing Novell Clients 15
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Preparing Client Workstations

Checking Client Workstation Requirements

Client workstations must meet certain requirements before you install or 
upgrade Novell Client software.

Workstation Hardware and Software

The Network Board

Novell Client supports NDIS* drivers. For information about installing the 
network board, refer to the manufacturer’s instructions.

NOTE: Remote Management in the full version of ZENworks for Desktops 
depends on Workstation Manager. If you plan to use Remote Management, make 
sure that Workstation Manager is installed on all workstations that will be managed 
remotely. Remote Management is not compatible with IP Gateway.

Platform Hardware Software

Windows 95/98 486 processor or 
better

Minimum 28 MB 
free disk space

Minimum 16 MB 
RAM

Windows 95/98 
(Windows 95 
must be version 
A or later or you 
must use Service 
Pack 1 from 
Microsoft.*)

Windows 95 or 
Windows 98 CD 
or the Windows 
.CAB files

Windows NT/2000 Minimum 
hardware 
requirements of 
Windows NT* 4.0

Minimum 
hardware 
requirements of 
Windows 2000

Minimum 24 MB 
RAM

Windows NT 4.0 
or Windows 2000 
(Windows NT 
must have 
Service Pack 3 or 
later.)
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Incompatibilities

Windows 95/98

The following network components are not compatible with Novell Client for 
Windows 95/98:

Microsoft Client for NetWare networks

Microsoft file and printer sharing for NetWare networks

Microsoft Service for NDS® software

Novell NetWare workstation shell 3.x (NETX)

Novell NetWare workstation shell 4.0 and later (VLMTM) clients

Novell IPX ODI protocol 16-bit module for the NETX and VLM clients

If any of these network components are installed, the client installation 
program detects the conflict and removes the conflicting network 
components.

Windows NT/2000

For up-to-date information about software incompatibilities, see the Novell 
Client for Windows NT/2000 readme file, WINNT.TXT.

Additional Information

“Installing Novell Client at the Workstation” on page 17

“Installing Clients from the Network” on page 19

Installing Novell Client at the Workstation

If you plan to install Novell Client software on a small number of 
workstations, or if the workstations are not yet connected to a network, install 
from the Novell Client CD or download it from the Novell Web site (http://
www.novell.com/download).

NOTE: If you are installing or upgrading Novell Client software on several 
workstations on the network, consider using the network installation explained in 
“Installing Clients from the Network” on page 19.

You can install the Novell Client using the Application Launcher component of 
ZENworksTM. Application Launcher lets you distribute applications such as the 
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client software to workstations and manage those applications as objects in the 
NDS tree. For more information, see the ZENworks for Desktops documentation.

The Novell Client Setup utility installs Novell Client software on workstations 
running Windows. This utility lets you select the client that you want to install 
from a list of available clients. Administrative options are also available.

To install at the workstation complete the following:

1 Do one of the following:

Insert the Novell Client CD.

If the Novell Client Setup utility does not automatically launch, run 
WINSETUP.EXE from the root of the CD.

Download the latest Novell Client software, and then follow the 
installation instructions included on the download page.

See “Downloading the Latest Client Software” on page 15.

If you require special monitor settings for accessibility, run the 
software from the DOS prompt using the /508 option to retain your 
monitor settings.

For Windows 95/98, enter path_to_the_software/
SETUP.EXE/508

For Windows NT, 2000, enter path_to_the_software/
SETUPNW.EXE/508

2 Click a language.

3 Click a platform.

4 Click the software to install.

This starts the installation utility for that software. 

5 Follow the on-screen instructions.

Once Novell Client is installed, check your network protocol configuration. 
See “Configuring Network Protocols” on page 19.
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Configuring Network Protocols

After you install Novell Client, make sure that it is configured correctly for 
your network.

WARNING: Before you configure network protocols, make sure you have the 
correct information and any addresses needed. If you configure protocols 
incorrectly, the workstation will not be able to connect to the network, or it may 
conflict with other workstations using the same address. 

1 Right-click Network Neighborhood, then select the protocol that you 
want to configure and click Properties.

2 Configure the protocol options in each tab, then click OK.

For example, if your network uses DHCP to assign IP addresses 
automatically, click the IP Address tab, then click Obtain IP Address 
Dynamically. Or, if you must use a static IP address, click Specify an 
Address and enter a valid IP address.

HINT:  Click the question mark in the upper-right corner, then click on any field for 
more information.

3 Click OK to make the changes.

NOTE: You might be prompted to supply the Windows operating system CD. If you 
do not have access to the correct files, you may not be able to create a network 
connection.

You should now set the Novell Client properties for the workstation. See 
Chapter 3, “Setting Client Properties,” on page 39.

Installing Clients from the Network

You can install Novell Client software on multiple workstations from the 
network by copying files to the server and modifying the login script. This 
installation is sometimes referred to as an Automatic Client Upgrade (ACU).

You can install and upgrade the client software on all platforms when users log 
in. The process involves six tasks:

Creating a folder on the server.

Copying Novell Client files and other required files to the new folder. 
Workstations can then read the files during login.

Granting rights to the new folder.

Modifying the ACU configuration file.
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(Optional) Creating or update the platform-specific configuration files.

Creating or modifying the login script. (A sample login script is 
included.)

When the login script runs, ACU.EXE determines if the client needs to be 
upgraded. This initial check saves network bandwidth during login since the 
setup utility is only run if the client needs to be updated.

Creating a Folder

1 Log in to a server as Admin or as a user with Admin equivalence.

Make sure that you have rights to copy files to a network folder that all 
users can access, as well as rights to modify login scripts.

2 Create a folder in SYS:PUBLIC.

For example,

SYS:\PUBLIC\CLIENT

Copying Files

1 Do one of the following:

1a From the Novell Client CD, copy the WINNT or WIN95 directories 
to the new folder.

If you are installing only one platform, you need to copy only the 
platform directory (WINNT or WIN95) for the platform you will 
install.

If you are installing the client in only one language or if your network 
does not have enough space to accommodate multiple language 
directories, you can delete the language directories that you do not 
need from the NLS directory under each client directory. To ensure 
that you have all necessary files, copy the entire client directory and 
then delete only the extra language directories.

1b Copy the downloaded Novell Client software files to the new folder.

See “Downloading the Latest Client Software” on page 15.

2 (Conditional) If you are installing Novell Client for Windows 95/98, copy 
the Windows 95 and/or Windows 98 .CAB files to the WIN95 directory.

The files are on the Microsoft Windows 95 or Windows 98 CD (and 
Upgrade CD) in the respective WIN95 or WIN98 folder.
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Granting Rights

1 Create a Group object in the NDS tree.

2 Place into that group users whose workstations need to be installed or 
upgraded.

3 Make sure that the group has Read and File Scan rights to the folder that 
you created.

NOTE: If you created a folder in SYS:PUBLIC, the new folder should have Read 
and File Scan rights already associated with it, but you should make sure that 
these rights have not been changed.

4 (Conditional) If you want the results of the installation to be added to a 
status log file, make sure that the group has Write rights to that file.

A status log file records the success or failure of the installation. As each 
workstation completes its installation, the status log file is appended to 
include information on that workstation. Enable status logging in the 
ACU configuration file.

NOTE: If you did not create the status log file prior to running the network 
installation, you must give users Create and Write rights to the directory.

Modifying the ACU Configuration File

The Automatic Client Upgrade utility (ACU.EXE) determines whether the 
client needs to be updated and allows you to specify several installation 
options.

Option Description Settings

[LAUNCHINSTALL] Specifies whether the platform-
specific setup utility will be launched 
once ACU.EXE determines that the 
installation is necessary.

Launch=Yes | No (default: 
Yes)

[DISPLAYDIALOG] Specifies whether users will be 
prompted to begin the upgrade.

Display=Yes | No (default: 
Yes)

[UNATTENDFILE] Specifies whether a platform-
specific configuration will be used 
and where it is located.

Use=Yes | No (default: No)

File=configuration file path
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To customize ACU, do the following:

1 Open the ACU.INI file located in the folder that you created on the server.

2 Modify the configuration options.

IMPORTANT: We recommend that you use the ACU.INI file instead of the 
command line switches used in previous versions of Novell Client. ACU.INI 
simplifies the installation process. If you choose to use switches, they will override 
ACU.INI options.

[STATUS 
LOGGING]

Specifies whether a status log will 
be created and where it will be 
located.

If you did not create a status log file 
prior to installation, it will be created 
and placed in the installation 
directory on the network or in the 
directory specified in the File 
setting.

Use=Yes | No (default: No)

File=log file path

[ADMINISTRATOR
MESSAGE]

Specifies additional text that will 
appear when the user is prompted 
to start an ACU.

Message=the message you 
want to appear

[CLIENTLOCAL
INSTALL]

Specifies whether the installation 
will be copied to a specified local 
directory and run locally. 

LocalInstall=Yes | No 
(default: No)

LocalDirectory=directory 
where you want the 
installation copied (default: 
C:\Novell\ClientLocalInstall)

DeleteLocalInstall=Yes | No 
(default: No)

NOTE: If you want to delete 
the files after the installation 
is complete, set the 
DeleteLocalInstall parameter 
to Yes.

Option Description Settings
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Updating the Platform-Specific Configuration Files

NOTE: If you are installing the client with the default settings, you do not need to 
create or modify the configuration files. Skip this process and proceed to Chapter 
3, “Setting Client Properties,” on page 39.

IMPORTANT: If you use a platform-specific configuration file to configure Novell 
Client, you must change the [UNATTENDFILE] option to Yes.

Each platform-specific installation utility reads a configuration file generated 
by Novell Client Install Manager in order to configure the client properties. 
This file provides information such as where to copy drivers during 
installation and the most recent version number. This file must be placed in the 
same folder as the installation utility.

IMPORTANT: If you are configuring Windows 95/98 workstations, options that 
were set in the NWSETUP.INI file or on the command line in previous versions of 
Novell Client (such as Display First Screen or CAB FIX) are now set up in Novell 
Client Install Manager.

To create a configuration file:

1 Start Novell Client Install Manager (NCIMAN.EXE).

For Windows 95/98, Novell Client Install Manager is located in the 
WIN95\IBM_language \ADMIN folder that you copied to the server.

For Windows NT/2000, Novell Client Install Manager is located in the 
WINNT\I386\ADMIN folder that you copied to the server.

2 Select File > New, then select the platform and click OK.

3 Modify the installation options as needed.

3a In the Installation Options list box, double-click the configuration 
option that you want to modify.

3b In the property pages, set the parameters and then click OK.

The values that you set appear in the right list box.

HINT: You can import the settings from a workstation that has been previously 
configured and save them to the configuration file. Once you set up the 
workstation, select File > Import Registry to import the settings.

4 Select File > Save.

You can use any filename—for example, UNATT_95.TXT or 
UNATT_NT.TXT.
Installing Novell Clients 23

Novell Client for Windows
103-000159-001
August 29, 2001

Novell Confidential



Manual 99a38 July 17, 2001
5 Copy this file to one of the following directories:

WIN95\IBM_language (for Windows 95/98)

WINNT\I386 (for Windows NT/2000)

IMPORTANT: The path to the text file cannot contain long filenames.

Creating or Modifying the Login Script

You need to modify login scripts for users whose workstations will be 
upgraded.

To upgrade workstations for users in a container, modify that container’s login 
script.

To upgrade workstations for users in a profile, modify that profile’s login 
script.

To upgrade specific users’ workstations, modify those users’ login scripts.

To upgrade a workstation running bindery-based client software (such as 
Microsoft Client for NetWare Networks which ships with Windows 95 or 
Windows 98), edit the system login script (SYS:PUBLIC\NET$LOG.DAT).

Creating or Modifying a Login Script Using ConsoleOne

To create or modify a login script using ConsoleOneTM:

1 Double-click the object whose login script you want to create or modify.

2 Click Login Script.

3 Enter the login script commands and information into the login script text 
box.

For a sample of the login script commands that you need to add to the 
scripts, see “Sample Client Installation Login Script” on page 25.

IMPORTANT: Make sure that you edit the sample login script to match the server 
names, directory paths, and specifications of your own network.

For additional information on all login script commands, see “Login 
Script Commands and Variables” on page 57.

4 To save the login script and close the Details dialog box, click OK.

If the login script that you just created was a container or user login script, 
you’re finished and the client software will be installed or updated the 
next time users log in.
24 Novell Client for Windows

Novell Client for Windows
103-000159-001
August 29, 2001

Novell Confidential



Manual 99a38 July 17, 2001
If the login script that you just created was for a Profile object, you must 
associate the User object with the Profile object and make the User object 
a trustee of the Profile object.

For additional information on all login scripts, see “Creating or 
Modifying Login Scripts” on page 30.

Sample Client Installation Login Script

The following sample shows the commands that you add to the login script in 
order to install the client software from the network. The sample includes 
sample text for installing across an internal network.

IMPORTANT: In this sample, the information that is necessary to the script is 
represented in uppercase letters. The information that you should customize for 
your network is in lowercase letters.

NOTE: If you are using this sample script to replace the Microsoft Client with Novell 
Client for Windows95/98, some user intervention is necessary. Due to Microsoft 
Client’s limited scripting capabilities, users must close an open DOS box before the 
workstation is rebooted and the installation is completed.

REM *****  Windows 95/98 *****
IF (OS = "WIN95") OR (OS = "WIN98" AND OS_VERSION <> "V4.90") THEN
   WRITE "Updating Novell Client for Windows 95/98."
   #\\server1\sys\public\client\win95\ibm_enu\acu.exe
   IF "%ERROR_LEVEL" = "1" THEN
        EXIT
   END
END

IF OS = "WINNT" AND OS_VERSION <> "V5.01" THEN
   WRITE "Updating Novell Client for Windows NT/2000."
   #\\server1\sys\public\client\winnt\i386\acu.exe
   IF "%ERROR_LEVEL" = "1" THEN
        EXIT
   END
END

What Users See

If this is a new client software installation, or if it is an upgrade from older 
client software, the software is installed or upgraded when users log in and 
restart the workstation. Users might see system messages as their workstations 
are upgraded, depending on how you set up the installation.
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Upgrading a Client Workstation to Windows 2000

You can upgrade a Windows 95/98 or Windows NT 4.0 workstation with 
Novell Client software to Windows 2000 without uninstalling the client 
software.

Windows 95/98 to Windows 2000: Installs Novell Client version 4.51 from 
the Windows 2000 CD.

Windows NT to Windows 2000: Detects the version of Novell Client 
software installed and does one of the following:

If the Novell Client version is 4.6 or earlier, Windows 2000 installs the 
Novell Client version 4.51 from the Windows 2000 CD.

If the Novell Client version is 4.7 or later, Windows 2000 leaves it intact 
but removes all installed components and changes the protocol selection.

After the migration to Windows 2000 is complete, Novell Client will reinstall 
the previously installed components and restore the previously selected 
protocols.

WARNING: In order to complete the reinstallation of the components and 
protocols, the user who logs in to the workstation after the migration must have 
Administrator rights.

Novell Client version 4.51 on the Windows 2000 CD has limited functionality. 
Therefore, you will want to upgrade to the latest Novell Client version once 
you have completed the upgrade. You can either access the latest client 
software from a product CD or download it from www.novell.com/download. 
Once you have set up the Automatic Client Upgrade (see “Installing Clients 
from the Network” on page 19), Novell Client will run an ACU from one of 
the following places:

The path pointed to by the NWCLIENTDIR environment variable in the 
login script or at the command line

The path were Novell Client was installed from

Drive Z: on the network

You may choose to skip the Automatic Client Upgrade by setting the 
NWCLIENTDIR environment variable to NULL in the login script.

For more information on Automatic Client Upgrade, see “Installing Clients 
from the Network” on page 19.

For more information on installing Novell Client on individual workstations, 
see “Installing Novell Client at the Workstation” on page 17.
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2 Setting Up Client Login

You can customize the client login environment to suit your network and have 
greater control over what users can access during login. This chapter contains 
information about the following:

Setting Up Login Scripts (page 27)

Setting Up Login Restrictions (page 34)

Setting Up Location Profiles (page 34)

Customizing the Novell Login Dialog Box (page 36)

Logging In to the Network (page 38)

Logging Out of the Network (page 38)

Setting Up Login Scripts

When a user successfully logs in to the network, Novell® Login executes one 
or more login scripts that automatically set up the workstation environment. 
Login scripts are similar to batch files and are executed by the Novell Login 
utility.

You can use login scripts to map drives and search drives to directories, 
display messages, set environment variables, and execute programs or menus.

Login scripts are properties of specific NDS® objects.

There are four types of login scripts:

Container: sets the general environments for all users in that container. 
Novell Login executes container login scripts first. Container login 
scripts can be associated with Organization or Organizational Unit 
objects. A user can use only one container login script.

NOTE: A container login script replaces the system login script from NetWare® 3.
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Profile: sets environments for several users at the same time. Novell 
Login executes a profile login script after the container login script. 
Profile login scripts are associated with profile objects. A user can be 
assigned only one profile login script but can choose other profile login 
scripts.

User: sets environments (such as printing options or an e-mail username) 
specific to a single user. Novell Login executes the user login script after 
any container and profile login scripts have executed. User login scripts 
are associated with User objects. A user can have only one user login 
script.

Default: contains only essential commands, such as drive mappings to 
NetWare utilities, and cannot be edited. It runs if a user (including user 
Admin) doesn’t have a user login script, even if a container or profile 
login script exists.

NOTE: If you don’t want to create any user login scripts and you don’t want the 
default login script to execute for any users, you can disable the default login script 
by including the NO_DEFAULT command in the container or profile login script.

Maintaining many user login scripts can be time-consuming. Therefore, you 
should try to include as much customization information as possible in the 
container and profile login scripts, which are fewer in number and easier to 
maintain.

For example, if all users need access to the NetWare utilities in the same 
volume, put the search drive mapping to that volume in a single container 
login script rather than in every user login script.

Create profile login scripts if several users have identical login script needs. 
Profile login scripts are sometimes thought of as group login scripts.

Finally, in user login scripts, include only those individual items that can’t be 
included in profile or container login scripts.

IMPORTANT: Since up to three login scripts can execute whenever a user logs 
in, conflicts can occur and drive mappings can be overwritten by consecutive login 
scripts. It is important to note that the last login script to execute (usually the user 
login script) overrides any conflicting commands in a previous login script.

IMPORTANT: In Windows NT* and Windows 2000, all drive mappings made 
using the NetWare login are root mapped. Because of this, programs cannot 
access directories above the directory that the drive is mapped to. If necessary, you 
can turn off the default by adding SET MAPROOTOFF="1" as the first line in the 
login script. This will globally force all NT workstations using the login script to not 
map root drives.
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WARNING: Don’t delete the login directory (SYS:LOGIN) created during network 
installation. It contains the Novell Login and NLIST utilities. If users run command 
line utilities, they can use these utilities to log in and view a list of available NetWare 
servers.

Where Login Scripts Should Be Located

Login scripts are properties of objects. Consequently, only certain objects can 
contain login scripts. This, in turn, largely determines where login scripts can 
be located.

The following figure shows how the different types of login scripts can reside 
in an NDS tree and how they affect users.

In the figure, there are three users: ESAYERS, SWILLIAMS, and 
MRICHARD. The following shows which login scripts execute when each of 
these users logs in.

For user ESAYERS: The SALES_PV container login script executes 
first, followed by ESAYERS’s user login script.

For user SWILLIAMS: The SALES_PV container login script executes 
first, followed by the default login script.
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For user MRICHARD: The ACCOUNTING container login script 
executes, followed by the CLERKS’ profile login script, and then 
MRICHARD’s user login script.

Container login scripts affect only users immediately below the Organization 
or Organizational Unit that contains the login script.

For example, in the figure, although there are two levels of container objects 
above users ESAYERS and SWILLIAMS, only the script for the container 
they’re in (OU=SALES_PV) executes when they log in.

If the SALES_PV Organizational Unit had no container login script defined, 
no container login script would execute for ESAYERS and SWILLIAMS, 
even though a container login script exists at a higher level.

Because user SWILLIAMS has no user login script defined, the default login 
script executes after the container login script.

Since user MRICHARD belongs to the profile CLERKS, the CLERKS profile 
login script executes before MRICHARD’s user login script. Users can be 
assigned to only one Profile object, but there are ways to get around this 
restriction. See “Getting Around the One Profile Login Script Restriction” on 
page 32.

Creating or Modifying Login Scripts

You can use ConsoleOneTM to create login scripts from scratch or from a 
sample login script that is provided for you. Using a sample login script can 
help reduce syntax errors and thus reduce the time it takes to create login 
scripts.

All four types of login scripts use the same conventions, commands, and 
variables. For more information, see “Login Script Commands and Variables” 
on page 57.

The main difference in creating container, profile, and user login scripts is the 
object that you select to contain the login scripts. The default login script is 
not assigned to any object.

Container login scripts are assigned to container objects (Organization or 
Organizational Unit objects).

Profile login scripts are assigned to Profile objects. In order for a User 
object to use a profile login script, you must select that User object and 
assign it to the Profile object.

User login scripts are assigned to User objects.
30 Novell Client for Windows

Novell Client for Windows
103-000159-001
August 29, 2001

Novell Confidential



Manual 99a38 July 17, 2001
IMPORTANT: Before you create or modify login scripts, you must have the Write 
property right to the object that will contain the login script. In addition, the 
Organization, Organizational Unit, Profile, or User object that you plan to assign the 
login script to must already exist.

To create or modify a login script using ConsoleOne complete the following 
steps:

1 Double-click the object whose login script you want to create or modify.

2 Click Login Script.

3 Enter the login script commands and information into the login script text 
box.

For a sample, see “Sample Login Scripts” on page 91.

IMPORTANT: Make sure that you edit the sample login script to match the server 
names, directory paths, and specifications of your own network.

For additional information on all login script commands, see “Login 
Script Commands and Variables” on page 57.

4 To save the login script and close the Details dialog box, click OK.

If the login script that you just created was a container or user login script, 
you’re finished and the client software will be installed or updated the 
next time users log in.

If the login script that you just created was for a Profile object, you must 
associate the User object with the Profile object and make the User object 
a trustee of the Profile object. 

For additional information on all login scripts, see “Creating or 
Modifying Login Scripts” on page 30.

Associating the User Object with a Profile Object

1 In ConsoleOne, double-click the User object that needs to use the profile 
login script.

2 Click Login Script.

3 Enter the name of the Profile object in the Default Profile field located 
under the login script text box, then click OK.

4 To add the User object as a trustee of the Profile object, double-click the 
Profile object.

5 Click NDS Rights > Trustees of this Object > Add Trustee.
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6 Enter the name of the User object that uses this Profile object.

7 Make sure that the Browse object and the Read property check boxes are 
checked, then click OK to assign these rights to the User object.

The User object is now a trustee of the Profile object and has the rights 
necessary to run the profile login script. Repeat these steps for all 
additional users who need to use this script.

Getting Around the One Profile Login Script Restriction

Users can belong to only one profile login script and so, as a rule, only one 
profile login script can be executed for any user. There are ways to run the 
equivalent of different or multiple profile login scripts by specifying other 
profile login scripts.

For example, to specify a different profile login script for a user at the 
command line, use the following command:

LOGIN username /p profile_object

You can also specify a different profile login script using ConsoleOne. On the 
user’s Login Script page, browse until you find the profile login script that you 
want to associate with the user, select it, and then click OK. For more 
information on associating a profile login script with a user, see the 
ConsoleOne help.

You can also assign users to more than one Group object. Use the MEMBER 
OF group identifier variable to execute different parts of a login script, 
depending on the Group objects that the user belongs to. To accomplish this, 
use the If...THEN command (see “IF...THEN” on page 73) and the MEMBER 
OF group identifier variable (see “Using Identifier Variables” on page 60).

To view an example of the IF...THEN command used with the MEMBER OF 
group identifier variable, see “Sample Login Scripts” on page 91.

Creating Login Scripts from a Sample or Existing Login Script

To create a login script from any of the samples included in this 
documentation or from an existing login script, complete the following steps:

1 Locate the sample or existing login script that you want to modify.

For sample login scripts included in this documentation, see “Sample 
Login Scripts” on page 91.

2 Copy the sample or existing login script.
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3 In ConsoleOne, open the login script, copy and then paste the sample into 
the login script.

4 Make necessary changes to the sample login script to customize it for 
your network.

IMPORTANT: Make sure that you edit the sample login script to match the server 
names, directory paths, and specifications of your own network.

5 Click OK to save the new login script.

If the login script that you just created was a container or user login script, 
you’re finished. If the login script that you just created was for a Profile 
object, you must associate the User object with the Profile object and 
make the User object a trustee of the Profile object. See “Associating the 
User Object with a Profile Object” on page 31.

Printing Login Scripts

To print a login script from the command line, use the NLIST command and 
redirect the output to a file or a printer. You must be in an object’s parent 
container to see and print the login script of that object.

IMPORTANT: You must have a workstation running DOS 3.30 or later and Read 
and File Scan property rights to the object to be printed.

To print a user’s login script, enter

NLIST user=username show "login script">LPT1

To print a container’s login script, enter

NLIST "organizational unit"="ou name" show "login 
script">LPT1

NOTE: Any option in the NLIST command that includes a space in its name must 
be enclosed in quotes.
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Setting Up Login Restrictions

Login restrictions are limitations on user accounts that control access to the 
network. These restrictions can be set in ConsoleOne for each user and include 
the following:

Requiring a password (you can specify its minimum length, whether it 
must be changed and how often, whether it must be unique, and whether 
the user can change it)

Setting the number of logins with expired password and the number of 
incorrect login attempts allowed

Setting account limits such as an account balance or expiration date

Limiting disk space for each user by specifying the maximum blocks 
available for each user on a volume

Specifying the number of simultaneous connections a user can have

Specifying, by node address, which workstations users can log in on

Restricting the times when users can log in (you can assign all users the 
same hours, or you can restrict users individually)

When a user violates login restrictions, the account is disabled and no one can 
log in using that username. This prevents unauthorized users from logging in.

Setting Up Location Profiles

Location profiles allow you to save the information from a user’s specific 
login into a location profile. When the user selects this profile during login, 
the profile automatically sets up login information such as the user’s name, 
server, tree, context, login script, and other applicable information so that the 
user does not have to type this information.

Location profiles are especially powerful for users who log in from multiple 
places. Users can have separate profiles for the office, home, laptop, or any 
other workstation they use. This simplifies the login process so that users do 
not have to remember their login information for each workstation. Using 
multiple location profiles also gives you control over what users can access 
from each workstation.

You can create a location profile on a single workstation or you can create 
location profiles for multiple workstations by using the ZENworksTM 
Workstation Configuration policy packages.
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HINT: To create and then distribute location profiles that will be used by multiple 
workstations, use the Novell Client Configuration policy created in the Workstation 
Configuration policy package in ConsoleOne. 

For more information on using ZENworks for Desktops policy packages, see the 
ZENworks for Desktops documentation. If you have questions while setting up a 
policy package, click Help.

To create a location profile on a specific workstation, complete the following 
steps:

1 Open the Client property pages.

Right-click the N icon in the system tray and click Novell Client 
Properties > Location Profiles.

or

Right-click Network Neighborhood and click Properties > Location 
Profiles.

2 Type the name of the profile that you want to add, then click Add.

3 From the Service menu, select one of the following:

Login Service to configure login settings, or

Connection Service to configure your dial-up connection settings

4 From the Service Instance menu, do one of the following:

Select an existing service instance, or

Enter a name for a new service instance, then click Add to specify the 
settings for this service in the Novell Client Login window or 
Connection Services window.

5 When you have finished creating the location profile, click OK.

HINT: When storing the profile through an NDS login, you can use a File System 
Pointer. This allows multiple users to use the same profile, provided they all use the 
same path as the file system pointer.

IMPORTANT: When storing the profile from a Windows NT 4.0 workstation on a 
NetWare server, that server volume must support long filenames. In versions of 
NetWare earlier than NetWare 4.11, the OS/2* name space was required for long 
filename support. In NetWare 4.11 and NetWare 5 or later, the LONG.NAM name 
space is required on the server.
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Removing a Location Profile

You may need to remove a location profile once it has been created. If you are 
removing a location profile created on an individual workstation, complete the 
procedure below. If you want to remove a location profile created in a Client 
Configuration policy, you can either delete the Client Configuration policy or 
change the associations of specific users with this policy.

1 Right-click the N icon in the system tray and click Novell Client 
Properties > Location Profiles to open the Novell Client property pages.

2 Select the name of the profile that you want to remove, then click 
Remove.

Customizing the Novell Login Dialog Box

The Novell Login dialog box can be customized to show the features that you 
want users to have access to. Customizing gives you control over:

The choice of NDS or bindery connection

The Location field at the top of the dialog box

Hiding the Location field is especially useful if you have set up only one 
location profile for a workstation. In this case, the Location field is not 
useful and might confuse or distract the user.

The Advanced button

If you have set up several location profiles and do not want users to 
change the data in various login fields (such as tree, context, server, run 
scripts, etc.), you can hide the Advanced button.

The Variables button on the Script tab

If you use %2, %3, %4, or %5 in the login script, you might want to set 
these values in the location profile but not allow the user to change them. 
In this case, it might be helpful to hide the Variables button.

The Clear Connections check box on the NDS and Bindery tabs

If you want all connections to be cleared every time the user logs in, or if 
you don’t want any connections to be cleared, you can set the value in the 
location profile and then hide the Clear Connections check box.

NOTE: The Clear Connections check box is never visible during initial login, 
because an initial login automatically clears all connections.
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The Workstation Only check box that appears under the Password field 
during an initial NT/2000 login

If you do not want to allow workstation-only logins—for example, if you 
want to require that the user log in to NetWare in order to use the 
workstation—you can hide the Workstation only check box.

The Run, Display, and Automatically Close properties of login scripts

RAS options, if RAS is installed on the workstation

These additional features of the Novell Login dialog box should also be 
considered:

If Dialup is not installed on the workstation, the fields on the Dialup tab 
are disabled.

If the Novell Login dialog box is being used to log in to a specific tree, 
the Tree field is disabled to prevent the user from changing the tree.

If the Novell Login dialog box is being used to log in to a specific NDS 
server, the Server and Tree fields on the NDS tab are disabled to prevent 
the user from changing them.

If the Novell Login dialog box is being used to log in to a specific bindery 
server, the Server field on the Bindery tab is disabled to prevent the user 
from changing the server.

The Novell Login dialog box can be customized to control the availability of 
certain login options. This gives you control over how users log in.

HINT: You can also customize the Novell Login dialog box for multiple 
workstations using the Novell Client Configuration policy created in the Workstation 
Configuration policy package in ConsoleOne (ZENworks for Desktops 3) or 
NetWare Administrator (ZENworks for Desktops 2).

For more information on using ZENworks for Desktops policy packages, see the 
ZENworks for Desktops online documentation. If you have questions while setting 
up a policy package, click Help.

To show or hide any login dialog box options, complete the following steps:

1 Right-click the N icon in the system tray and click Novell Client 
Properties > Location Profiles to open the Novell Client property pages.

2 Click Advanced Login.

3 In the Show On Login section of the Advanced Login property page, 
check the check boxes for the items that you want to appear, and clear 
those that you do not want to appear.
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Logging In to the Network

IMPORTANT: We recommend that users do not use the command line LOGIN 
utility.

There are several ways to initiate a Novell Client Login once users have 
already logged in to NetWare or to the local workstation:

Right-click the red N icon in the System Tray and click NetWare Login. 

Right-click Network Neighborhood and click NetWare Login.

Click Start > Programs > Novell (Common) > Novell Login.

In Network Neighborhood, double-click the tree or server that users want 
to log in to; the Novell Login will load automatically.

In Network Neighborhood, right-click on the desired tree or server and 
choose either Authenticate or Login.

Run LOGINWIN32.EXE from the DOS command prompt.

Logging Out of the Network

To log in to new NetWare services while logging out of other servers or 
clearing the current connections, use the NetWare Client Login and check the 
Clear Current Connections check box.

If you want to log out of both the Windows NT/2000 workstation and 
NetWare, press Ctrl+Alt+Del and click Logout.

To log out of a specific server, right-click Network Neighborhood, click 
NetWare Connections, select the server or tree, and then click Detach.

IMPORTANT: We recommend that users do not use the LOGOUT.EXE 
command. If you use this command, specify a server name (LOGOUT 
server_name).

Setting Up Passwords in Windows NT/2000

We recommend that you configure NT workstations to not use any of the 
Microsoft password restrictions available in User Manager. Novell Client for 
Windows NT works best if password restrictions are set in NDS.
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3 Setting Client Properties

You can optimize Novell® ClientTM for your network by using property pages 
to configure installation options and protocol support, optimize performance, 
configure optional client parameters, and set a variety of other parameters.

By default, the client is configured for high speed with moderate use of 
memory and data protection. You can adjust the client to optimize its 
performance in any of these areas. However, optimizing the client in one area 
might lessen performance in other areas.

HINT: A new Advanced Menu Settings tab has been added to the Novell Client 
Property Page. This tab lets you set menu options and control settings such as the 
ability to send messages to the server console or how Network Neighborhood is 
configured. A short description of each setting is available in the Description field 
when you highlight the option.

NOTE: Additional information on the Advanced Settings is available in an April 
1999 AppNotes® article (http://developer.novell.com/research/appnotes/1999/
april/03/index.htm).

You can set properties for a single workstation, or you can set them for 
multiple workstations simultaneously.

Setting Properties Prior to Installation

Use Novell Client Install Manager to set properties for one or more 
workstations prior to an unattended install. This method saves you from 
having to set each workstation individually.

1 Start the Novell Client Install Manager.

Novell Client Install Manager is located on the CD-ROM or in the Novell 
Client download in the WIN95\IBM_language >ADMIN directory.

2 Click File > New File > your operating system.
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3 Modify the installation options as needed by doing the following:

3a Double-click the configuration option that you want to modify in the 
Installation options list box.

3b In the property pages, set the parameters, and then click OK.

The values that you set appear in the right list box.

HINT: You can set up one workstation the way you want other workstations set 
up, and then use Novell Client Install Manager to import the settings from that 
workstation’s registry and save them to the configuration file you will use during the 
ACU install. Once you set up the workstation, click File > Open Registry to import 
the settings into Novell Client Install Manager.

For information about setting properties on a single workstation, see “Configuring 
Network Protocols” on page 19.

4 Click File > Save.

You can save the file with any filename that you want to use. For example, 
you could rename the file NOVELL.TXT and then use it in conjunction 
with the ACU.

Setting Properties on a Single Workstation After 
Installation

1 At the user’s workstation, right-click the N icon in the system tray.

2 Click Novell Client Properties.

3 Set the properties that you want to change.

4 Click OK to make the changes and close the property pages.

Setting Properties on Multiple Workstations After 
Installation

Beginning with ZENworksTM for Desktops 3 or later and NetWare® 5 or later, 
you can use ConsoleOne to configure client properties for multiple 
workstations. The properties that you set in ConsoleOne or NetWare 
Administrator are pushed down to the client workstations at scheduled times 
or when specified events occur, such as when a user logs in.

To set the properties on multiple workstations after installation, refer to the 
corresponding ZENworks for Desktops documentation at Novell’s 
documentation web site (http://www.novell.com/documentation/) for more 
information.
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Specifying Global Settings

Novell Client for Windows* NT/2000 software provides a custom policy 
template for use with the Windows NT* and Windows 2000 System Policy 
Editor (POLEDIT.EXE). You can use the System Policy Editor and the Novell 
Client for Windows NT/2000 template to create a policy file that specifies the 
values for Novell Client for Windows NT/2000 settings.

The policy file is a .POL file that contains Windows NT/2000 Client Policy 
settings. These are settings that are created and edited with ConsoleOne by 
using the Microsoft POLEDIT utility with the NT/2000 Client template. The 
policies are applied or written to the registry when a user logs in to the 
network.

After ensuring that the settings in the policy file work correctly, save the 
policy file as SYS:\PUBLIC\WINNT\NTCONFIG.POL on every preferred 
server. The Novell Client for Windows NT/2000 settings are read from the 
policy file and then stored in the registry each time a user logs in to the 
network.

The policy file that is used is the one in the SYS:\PUBLIC\WINNT directory 
of the preferred server. If no preferred server is specified, the policy file in the 
SYS:\PUBLIC\WINNT directory of the server with the first connection is 
used.

The primary documentation for the System Policy Editor is in the Microsoft* 
Windows NT/2000 Resource Kit.

To ensure that your policy will run, the following registry setting must be set 
to 1 (the default):

\\HKLM\System\CurrentControlSet\Control\Update\UpdateMode:DW
ORD:1

ConsoleOne makes it possible to set up user and workstation policies. For 
more information, refer to the ZENworks for Desktops online documentation.
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Using DHCP

If a DHCP server is set up on your network, the DHCP server can inform 
Novell Client of network-specific configuration information.

You can easily configure Novell DHCP servers (NetWare 5 and later) to 
distribute this information to the clients. See the server configuration 
documentation for your NetWare product.

Clients obtain configuration information from DHCP even when you 
statically configure the client’s IP address or even when the DHCP server used 
to supply the information is different from the DHCP server supplying an IP 
address to the client.

Using DHCP as an NDS Server Name Service Provider

You can set up a DHCP server to inform Novell Client workstations that use 
the IP protocol about an NDS tree name and the IP addresses of servers that 
are on that tree. When using this feature, it is best to specify the IP addresses 
of the closest NDS servers containing partitions with the user information.

Using DHCP to Distribute SLP Configuration Information

You can configure the following SLP parameters through DHCP:

IP Address of SLP Directory Agents 

SLP Scopes

Using DHCP to Distribute IPX Compatibility Information

You can configure the following IPX Compatibility parameters through 
DHCP:

IP Address of Migration Agents

CMD Network Number

Migration Agent List Stale Time
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4 Managing Novell Client

Managing Novell® ClientTM requires that you manage users’ network 
connections, passwords, rights and other security issues, etc. All of these 
features are available from the Novell Client desktop.

Common Networking Tasks

Novell® ClientTM software is integrated with Windows*. Features are 
integrated into standard Windows interfaces such as My Computer, Network 
Neighborhood, Control Panel, and the N icon in the system tray.

Instructions for performing common client tasks are provided under the N 
menu:

1 Right-click the N icon.

2 Click Novell Client Help > Novell Client User Guide.

NetWare File Security

NetWare® networks restrict access to network files and folders based on user 
accounts. For example, a user connected to the network using the 
administrator account might be able to delete or rename a file that other users 
can only open and edit.

The NetWare file system keeps track of the rights that users have to files and 
directories on the network. When users try to access any file on a NetWare 
network, NetWare either grants access or prohibits certain things that users 
can do with the file.

Rights are granted and revoked by creating trustee assignments. For more 
information, see “Changing Trustee Assignments” on page 44.
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File rights apply only to the file that they are assigned to. The rights can be 
inherited from the folder that contains the file. Folder rights apply not only to 
the folder but also to the files and folders it contains.

Checking File or Folder Rights

1 In Windows Explorer or Network Neighborhood, right-click the file that 
you want to check.

2 Click Properties > NetWare Rights.

3 In the Trustees box, click on the user account. The rights to the file or 
folder will be displayed on the right-hand side.

Changing Trustee Assignments

1 In Windows Explorer or Network Neighborhood, right-click the file that 
you want to check.

2 Click Properties > NetWare Rights.

3 Add trustees, remove trustees, or change the rights granted to trustees as 
needed.

NOTE: Trustee assignments override inherited rights.

You must have the Supervisor right to change trustee assignments.

To change an Inherited Rights Filter, click on the Inherited Rights and Filters button 
on the NetWare Rights property page.

Combining Multiple Trustees

As an administrator, you might need to apply the same trustee assignments to 
a group of selected files. You can combine trustee assignments by checking 
the Combine Multiple Trustees check box on the NetWare Rights page.

1 In Windows Explorer or Network Neighborhood, click a file that you 
want to check.

2 Press and hold Control while clicking additional files.

3 Right-click the selected files.

4 Click Properties > NetWare Rights.

Because multiple files are selected, the Combine Multiple Trustees check 
box is enabled.
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NOTE:  This check box is available only if you’re viewing the NetWare rights for 
multiple files or folders. Additionally, at least one of the files or folders must have 
at least one trustee assignment. The trustees and rights shown are the combined 
trustees and rights for all the files.

5 Check or uncheck the check box.

NOTE: If you check Combine Multiple Trustees, the trustee assignments that are 
shown will apply to all selected files after you click OK or Apply.

6 Click OK.

For example, Kim is a trustee of FILE_A and FILE_B. Kim has Read, File 
Scan, and Access Control rights for FILE_A and Read and File Scan rights for 
FILE_B. If you select FILE_A and FILE_B and view their properties, Kim is 
shown as a trustee with Read, File Scan, and Access Control rights.

If you check Combine Multiple Trustees and then click OK, Kim is given the 
Access Control right for FILE_B. Therefore, Kim now has Read, File Scan, 
and Access Control rights for both FILE_A and FILE_B.

Setting Up AutoAdminLogon for Windows NT/2000

Windows NT* and Windows 2000 can automate the logon process by storing 
passwords and other pertinent information in the Registry database.

WARNING: There is a security risk to using the AutoAdminLogon feature. 
Usernames and passwords in the registry are visible to users. This feature also 
allows other users to start the computer and use the account that to automatically 
logon even if the workstation is locked. Please see the Microsoft recommendations 
on when to use AutoAdminLogon.

Use Registry Editor (REGEDIT.EXE) to add the needed logon information. 

WARNING: Using Registry Editor incorrectly can cause serious, system-wide 
problems that may require reinstalling Windows NT or Windows 2000 to correct 
them.

HINT: To bypass the AutoAdminLogon process, and to log in as a different user, 
hold down the Shift key after a logout or after a Windows NT restart.
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AutoAdminLogon Options

This section lists the options that you can choose from when setting 
AutoAdminLogon. To set the options, use the procedure in “Setting the 
AutoAdminLogon Options” on page 48.

AutoAdminLogon for Windows Workstation Only

AutoAdminLogon for Windows Workstation and NetWare

HINT: Location profiles allow you to save a user’s specific login information. The 
profile automatically sets up login information such as the user’s name, server, 
tree, context, login script, and other applicable information so that the user does 
not have to type this information. See “Setting Up Location Profiles” on page 34.

NOTE: The NT Credential information in the Location Profile will not be used. The 
NT user information in the registry will be used instead.

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=<Name 
of Domain or Local Workstation>

DefaultUserName=<Windows User Name>

DefaultPassword=<Windows Password for the 
DefaultUserName specified above>

AutoAdminLogon=0

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=<Name 
of Domain or Local Workstation>

DefaultUserName=<Windows User Name>

DefaultPassword=<Windows Password for the 
DefaultUserName specified above>

AutoAdminLogon=1

DefaultLocationProfile=Name of the Location 
Profile that contains the information about the 
Novell User to log in to the NetWare network such 
as Username, Tree, Context, Server, etc.

DefaultPassword=Novell Password for the 
DefaultUserName specified in the Location Profile
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AutoAdminLogon for NetWare Only Using Dynamic Local User (DLU) for Windows

HINT: Location profiles allow you to save a user’s specific login information. The 
profile automatically sets up login information such as the user’s name, server, 
tree, context, login script, and other applicable information so that the user does 
not have to type this information. In this case, the location profile must specify an 
NDS user with Dynamic Local User (DLU) privileges on the Windows NT or 
Windows 2000 workstation. See “Setting Up Location Profiles” on page 34. 

AutoAdminLogon for Windows and Query for NetWare

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=0 AutoAdminLogon=1

DefaultLocationProfile=Name of the Location 
Profile that contains the information about the 
Novell User to log in to the NetWare network such 
as Username, Tree, Context, Server, etc.

DefaultPassword=Novell Password for the 
DefaultUserName specified in the Location Profile

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=<Name 
of Domain or Local Workstation>

DefaultUserName=<Windows User Name>

DefaultPassword=<Windows Password for the 
DefaultUserName specified above>

AutoAdminLogon=0

AutoAdminQueryNDS=1
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AutoAdminLogon for NetWare under Terminal Server

Turn Off AutoAdminLogon

Setting the AutoAdminLogon Options

To set the options:

1 Start Registry Editor (REGEDIT.EXE).

2 Locate the specified Registry keys and set the values as indicated.

NOTE: If a value does not exist, choose Edit > New > String Value. Type the name 
of the value, then press Enter.

IMPORTANT: If no DefaultPassword string is specified, the value of the 
AutoAdminLogon key is automatically changed from 1 (true) to 0 (false), disabling 
the AutoAdminLogon feature.

3 Exit the Registry Editor and log out of Windows NT or Windows 2000.

Changing Passwords in NetWare Login with AutoAdminLogon

If AutoAdminLogon is enabled, be careful when running the NetWare Login 
utility from the icon in the NetWare (Common) group. When run as a 
standalone utility from the icon, NetWare Login does not recognize that the 
workstation is running AutoAdminLogon.

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

 AutoAdminLogon=1

DefaultLocationProfile=Name of the Location 
Profile that contains the information about the 
Novell User to log in to the NetWare network such 
as Username, Tree, Context, Server, etc.

DefaultPassword=Novell Password for the 
DefaultUserName specified in the Location Profile

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
WindowsNT\CurrentVersion\Winlogon

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ 
Login

AutoAdminLogon=0 AutoAdminLogon=0
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If the primary connection’s password expires when running NetWare Login 
from the icon, the user will be given the chance to synchronize all NetWare 
and NT passwords. Make sure that users do not synchronize the NT password, 
because NetWare Login does not update the Registry setting for 
AutoAdminLogon.

Uninstalling Novell Client

You can uninstall the Novell Client by using the uninstall utility or by 
selecting Remove in Network Properties.

For Windows 95/98, double-click the uninstall utility (UNC32.EXE) 
located in the WIN95\language_directory\ADMIN directory.

For Windows NT/2000, in the Network Properties, click Services > 
Novell Client for Windows NT/2000 > Remove, then click Yes.
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5 Printing to a Network Printer

Printer setup can be automated so that users’ workstations attach to the 
network printers they use each time users log in to the network. Users can use 
the network printers without having to manually connecting to the printer 
every time they want to print.

After connecting to a network printer, users can select the printer from any 
application that they are using. See the application’s documentation for 
information on using printers.

Attaching to a Network Printer

Users can set up network printing on a workstation by specifying the name of 
the printer in any of the following programs:

Windows Add Printer Wizard

Novell® Capture Printer Port

NOTE:  A printer driver for each type of printer must be installed on the 
workstations.

The following can automate printer connections so that the computer connects 
to network printers each time a user log in:

NetWare® Login Script

NT/2000 Restore Connections

NT/2000 Logon Script
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Setting Up Network Printing

Provide users with the following instructions for setting up network printing:

1 Click Start > Settings > Printers.

2 Double-click Add Printer.

3 Click Network Printer Server > Next.

4 Select a printer you want to use from the Shared Printers box.

For NetWare 4.x or NetWare 5 or later (NDS®) networks, double-
click Novell Directory Services® and find the context for the printer. 
Then select a Printer object from the list.

For NetWare 3.x and bindery networks, double-click NetWare 
Servers. Double-click the name of the server that supports the queues 
you want to use, then select the queue.

5 Click OK.

6 (Conditional) If a dialog box prompts you to install a driver for the printer, 
click OK and install it.

6a Select the name of the printer from the Driver box, then click OK.

6b Enter the path to the printer driver, then click OK.

7 Run an application and select the network printer when you print.

Specifying Capture Settings with Windows Printing

Windows does not require captured printer ports to print to a network printer. 
Windows can use print devices that are associated with network printers. This 
allows applications to print directly to a network printer.

The CAPTURE utility does not affect Windows printer devices.

Captures are global. If you capture a printer port, the port is available for 
network printing from anywhere in Windows.

Use the Capture Settings dialog box to specify printer settings for print 
captures created with Windows. This can be useful if you want to use a DOS 
or Windows 3.x application that relies on print captures and you can’t put the 
capture in a login script.
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To access the Capture Setting dialog box, complete the following steps:

1 Right-click the N icon in the system tray.

2 Click Novell Capture Printer Port.

3 Enter the correct information in the dialog box.

4 Click Settings.

These settings apply only to printer ports that are captured from Windows. 
Printer ports that are captured in a login script or from the command line do 
not use these settings.

These settings do not apply to printers that appear in the Windows Printers 
folder.

Changing the printer settings for a specific captured printer port does not 
change the default printer settings.

Setting Up Point and Print

1 Get the printer driver files.

Get the Windows operating system CD-ROM or the Windows printer 
driver files supplied by the printer’s manufacturer.

2 Log in as Admin or as a user with Admin equivalent rights for the printer 
or print queue.

3 Select a printer or print queue in the Windows Explorer or Network 
Neighborhood.

4 Click File > Properties > Setup Point and Print.

5 Specify the path for the printer driver files.

You must be logged in to the tree or server where the path is located. You 
must also have sufficient rights for the specified directory to copy the files 
there. Users need Read and File Scan rights for the specified directory.

6 Click Select Printer Model.

7 Select the manufacturer of the printer.

8 Select the model of the printer.

9 Click OK.

The printer driver files are copied to the path specified in Step 5.

10 Click OK again.
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Printing DBCS Characters from DOS in Windows NT/
2000

In Windows NT* and Windows 2000, the default command window runs as a 
32-bit process. In order to use the existing DOS printer driver for DOS-
intrinsic commands, you must use a 16-bit command window.

This allows DOS-intrinsic commands such as COPY, TYPE, etc., to use the 
print driver.

The following instructions explain how to set up NT to support this. These 
instructions also set up the NT system to support the printer driver for DOS 
applications.

1 Edit the AUTOEXEC.NT file, found in the 
%SYSTEMROOT%\SYSTEM32 directory, adding the DOS printer 
driver for your specific printer. Add the printer driver after the following 
line:

 %SYSTEMROOT%\SYSTEM32\VLMSUP.EXE

Make sure that you copy the printer driver to the path you specify in the 
AUTOEXEC.NT file.

2 Save a copy of the WINNT_DIRECTORY\SYSTEM32\CONFIG.NT file 
with another filename, such as CONFIG.PRT.

3 Edit the new CONFIG file, adding the DOSONLY command to the file.

4 Continue the setup process using the instructions for your specific version 
of Windows NT:

4a  Create a shortcut to the COMMAND.COM program, found in the 
WINNT_DIRECTORY\SYSTEM32 directory.

4b Right-click the shortcut icon, then click Properties.

4c On the Program property page, click Windows NT and enter the 
paths for the CONFIG and AUTOEXEC files that you created in 
Steps 1 and 2.

4d Double-click the shortcut icon. A DOS window will open.

Only DOS applications can be run from this window, but anything that is 
printed will be rendered by the printer driver that you installed. Any DOS 
commands that affect the print driver must be entered in this window. DOS 
applications can be started by any method.
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Disabling NetWare Login Dialog Boxes Brought Up by 
the Print Provider

If users log in to a workstation but do not log in to NetWare and they have 
NetWare printers installed, they will be prompted to log in to NetWare once 
by the QMS print provider and once by the NDPS print provider. These login 
dialog boxes can be disabled if desired.

Windows NT/2000

Windows NT/2000 has two registry setting options for disabling login dialog 
boxes:

If you set

HKLM\SOFTWARE\Novell\Print\Delay Login\Delay Login=1

the print provider tells Windows that the printer is a NetWare printer even 
though the user is not authenticated. Then, the provider waits for an action that 
requires authentication is detected before displaying a login dialog box.

If you set

HKLM\SOFTWARE\Novell\Print\Never Login\Never Login=1

the print provider never displays the NetWare login dialog, and print jobs sent 
prior to authentication fail. A message similar to the following is displayed:

"Error writing to \\TREE\QUE.context: A write fault occurred 
on the network. Do you wish to retry or cancel the job?"

Windows 95/98

Windows 95/98 has two registry setting options for disabling login dialog 
boxes:

If you set

HKLM\SOFTWARE\Novell\Print\Never Login\Never Login=1

the print provider never displays the NetWare login dialog. Print jobs will 
succeed, but the printer will go offline. To print, you must log in to NetWare 
and then manually turn the printer online by opening the Printers folder, right-
clicking on the Printer, and deselecting Print Offline.
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If you set

HKLM\SOFTWARE\Novell\Print\Never Login\UserDialupSettings=1

the print provider sets Never Login to the dial-up connection settings and 
attempts to print.

NOTE: This functionality is available only in Windows 95B or later.
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A Login Script Commands and Variables

This appendix lists login script commands alphabetically and by the type of 
tasks the commands perform. It also contains a list of identifier variables used 
in login scripts.

Before implementing any commands or variables, make sure you understand 
basic login script conventions. See “Login Script Conventions” on page 57 
and “Using Identifier Variables” on page 60.

NOTE: Commands that work only on DOS or Windows* 3.x workstations have not 
been included. These commands include CLS, COMSPEC, DOS VERIFY, 
MACHINE, NOSWAP, and SWAP. For information on using these commands, see 
the help file that accompanies Novell® ClientTM for DOS and Windows 3.x.

Login Script Conventions

The following table explains the conventions you should follow when creating 
login scripts.

Minimum login script No minimum. All types of login scripts are optional. Login scripts 
can vary from one line to many. There are no required 
commands.

Case Either uppercase or lowercase is accepted. Exception: identifier 
variables enclosed in quotation marks and preceded by a 
percent sign (%) must be uppercase. See “Using Identifier 
Variables” on page 60.

Characters per line Maximum 512 characters per line, including any variables after 
they are replaced by their values; 78 characters per line 
(common screen width) is recommended for readability.
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Punctuation and symbols Type all symbols (#, %, ", _) and punctuation exactly as shown 
in examples and syntax.

Commands per line Use one command per line. Start each command on a new line; 
press Enter to end each command and start a new command.

Lines that wrap automatically are considered one command.

Sequence of commands Generally, enter commands in the order that you want them to 
execute, with the following restrictions: 

ATTACH commands (NetWare® 3 only) must precede related 
MAP commands to avoid prompting the user for a username/
password during login (see “ATTACH” on page 67).

If you use # (see “#” on page 65) or@ (see “@” on page 66) to 
execute an external program, the command must follow any 
necessary MAP commands. If sequence is not important, group 
similar commands, such as MAP and WRITE commands, 
together to make the login script easier to read.

Blank lines Blank lines don’t affect login script execution. Use them to 
visually separate groups of commands.

Remarks (REMARK, REM, 
asterisks, and semicolons)

Lines beginning with REMARK, REM, an asterisk, or a 
semicolon are comments, which don’t display when the login 
script executes (see “REMARK” on page 82). Use remarks to 
record the purpose of each command or group of commands or 
to temporarily keep certain lines from executing.

Identifier variables Type identifier variables exactly as shown. To display the value 
of an identifier variable as part of a WRITE command, you must 
enclose the identifier in quotation marks and precede it by a 
percent sign (%). See “Using Identifier Variables” on page 60.
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NDS Attribute Values Any NDS® attribute value can be read from a login script, 
including extended names. The syntax for accessing NDS 
attributes is identical to common script variables with a few 
exceptions. 

The NDS attribute must be at the end of the string. 

If multiple variables are required, they must be in separate 
strings. 

You must use the actual NDS attribute value names. You 
cannot use localized names or nicknames. Some common 
NDS attribute names are listed in “Using Identifier Variables” 
on page 60. 

You must have Read rights to read the value of objects other 
than values associated with your own User object. 

NOTE: If the name contains a space, you can replace it with an 
underscore “_” but it is not required. Both of the following 
examples are correct syntax: map n %home directory or map n 
%home_directory. 

NDS Object Mappings NDS objects such as cluster-enabled volumes can be mapped 
in the login script using the object’s fully distinguised name and 
context preceeded by a leading dot (.). 

To map to a cluster-enabled volume, you would use the 
following syntax:

MAP N:= .<NDS object's fully distinguished name 
including context>

For example: 

MAP N:= .cluster2_vol1.xyz.provo.novell

For more information on mapping, see “MAP” on page 78. 
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Using Identifier Variables

Many login script commands allow you to take advantage of identifier 
variables to make login scripts more efficient and flexible.

Use identifier variables to enter a variable (such as LAST_NAME), rather 
than a specific name (such as Smith), in a login script command. When the 
login script executes, it substitutes real values for the identifier variables.

By using the variable, you can make the same login script command 
applicable to multiple users.

When using variables within login script commands, observe the following 
conventions:

Type the variable exactly as shown.

To use environment variables as identifiers, enclose them in angle 
brackets (< >).

Identifier variables are used most often with commands such as 
IF...THEN, MAP, and WRITE. They can also be used with commands 
that you can specify a path for, such as COMSPEC.

Identifier variables can be placed within literal text strings in a WRITE 
statement. However, the identifier variable must be in uppercase letters 
and preceded by a percent sign. (Literal text is the text that is displayed 
on the screen, such as “Sales report is due today.” Literal text must be 
enclosed in quotation marks.)

For example, using the %LAST_NAME variable substitutes the user’s actual 
last name for the LAST_NAME variable in the command when the user logs 
in.

WRITE "HELLO, "%LAST_NAME

displays the following message on Bob Smith’s workstation screen when he 
logs in:

Hello, SMITH

Using the %GREETING_TIME variable, displays the time of day. If Bob 
Smith logs in during the morning, both of the following lines display the same 
message (Good morning, SMITH) on his screen:

WRITE "Good "; GREETING_TIME;", "; LAST_NAME

WRITE "Good %GREETING_TIME,%LAST_NAME"
60 Novell Client for Windows

Novell Client for Windows
103-000159-001
August 29, 2001

Novell Confidential



Manual 99a38 July 17, 2001
Category Identifier Variable Function

Date DAY Day number (01 through 31)

DAY_OF_WEEK Day of week (Monday, Tuesday, etc.)

MONTH Month number (01 through 12)

MONTH_NAME Month name (January, February, etc.)

NDAY_OF_WEEK Weekday number (1 through 7; 1=Sunday)

SHORT_YEAR Last two digits of year (99, 00, 01)

YEAR All four digits of year (1999, 2000, 2001)

Time AM_PM a.m. or p.m.

GREETING_TIME Time of day (morning, afternoon, evening)

HOUR Hour (12-hour scale; 1 through 12)

HOUR24 Hour (24-hour scale; 00 through 23)

MINUTE Minute (00 through 59)

SECOND Second (00 through 59)

User CN User’s full login name as it exists in NDS

LOGIN_ALIAS_CONTEXT "Y" if REQUESTER_CONTEXT is an alias

FULL_NAME User’s unique username. It is the value of the 
FULL_NAME property for both NDS and bindery-
based NetWare. Spaces are replaced with 
underscores.

LAST_NAME User’s surname in NDS, or full login name in 
bindery-based NetWare

LOGIN_CONTEXT User’s context

LOGIN_NAME User’s unique login name (long names are 
truncated to eight characters)

MEMBER OF "group" Group object that the user is assigned to
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User (cont’d.) NOT MEMBER OF "group" Group object that the user is not assigned to

PASSWORD_EXPIRES Number of days before password expires

REQUESTER_CONTEXT Context when login started

USER_ID Number assigned to each user

Network FILE_SERVER NetWare server name

NETWORK_ADDRESS The internal number assigned by the network 
specifying where a device can be located in the 
network cabling system

Workstation MACHINE Type of computer (IBM_PC, etc.)

NETWARE_REQUESTER Version of the NetWare RequesterTM for OS/2* or 
VLMTM users

OS Type of operating system on the workstation

OS_VERSION Operating system version on the workstation

P_STATION Workstation’s node number (12-digit 
hexadecimal)

PLATFORM Workstation’s operating system platform

SHELL_TYPE Version of the workstation’s DOS shell; supports 
NetWare 2 and NetWare 3 shells and NetWare 4 
Requester for DOS.

SMACHINE Short machine name (IBM*, etc.)

STATION Workstation’s connection number

WINVER Version of the workstation’s Windows operating 
system

NetWare 
MobileTM

DIALUP 0 = Not using dialup

1 = Using NetWare Mobile Client dialup profile 

OFFLINE 0 = Not offline

1 = Disconnected login

Category Identifier Variable Function
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Login Parameters with %n Variables

Some variables in a login script can be indicated by a percent sign (%) 
followed by a number from 0 through 9.

NOTE: Only four variables (%2 through %5) can be changed in the login screen.

When a user logs in, additional parameters can be entered that the login utility 
passes to the login script. The login utility then substitutes these parameters 
for any %n variables in the login script. These variables are replaced in order 
by the parameters the user entered when logging in.

The %0 variable is replaced by the name of the NetWare server entered in the 
login dialog box, and %1 is replaced by the user’s fully distinguished login 

DOS 
Environment

<variable> Any DOS environment variable can be used in 
angle brackets. To use a DOS environment 
variable in MAP, COMSPEC, and FIRE 
PHASERS commands, add a percent sign (%) in 
front of the variable.

Miscellaneous ACCESS_SERVER Shows whether the access server is functional 
(TRUE = functional; FALSE = nonfunctional)

ERROR_LEVEL An error number (0 = no errors)

%n Replaced by parameters the user enters at the 
command line with the login utility

See “Login Parameters with %n Variables” on 
page 63.

Object Properties property_name You can use property values of NDS objects as 
variables. Use the property values just as you do 
any other identifier variable. If the property value 
includes a space, enclose the name in quotation 
marks.

To use a property name with a space within a 
WRITE statement, you must place it at the end of 
the quoted string:

WRITE"Given name=%GIVEN_NAME" 
IF"MESSAGE SERVER"="MS1" THEN MAP INS 
S16:=MS1\SYS:EMAIL END

Category Identifier Variable Function
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name. The remaining variables change, depending on what the user types 
when executing the login utility. The %n variables must precede all command 
line options.

The “SHIFT” on page 85 login script command allows you to change the order 
in which these %n variables are substituted.

Login Scripts Commands by Task

This list identifies which specific login script commands to use, depending on 
what you need your login scripts to accomplish.

Network Connection and Access to Resources

ATTACH (page 67)

CONTEXT (page 68)

DRIVE (page 69)

MAP (page 78)

TREE (page 88)

Login Script Execution

BREAK (page 68)

FIRE or FIRE PHASERS (page 71)

GOTO (page 72)

IF...THEN (page 73)

INCLUDE (page 76)

NO_DEFAULT (page 80)

PAUSE (page 81)

PROFILE (page 81)

SCRIPT_SERVER (page 83)

SHIFT (page 85) 
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Workstation Environment

SET (page 83)

SET_TIME (page 85)

Text File Usage

@ (page 66)

# (page 65)

DISPLAY (page 69)

EXIT (page 70)

FDISPLAY (page 70)

TERM (page 87)

WRITE (page 89)

Other

LASTLOGINTIME (page 78)

REMARK (page 82)

#

Use the # symbol to execute a program that is external to the login script. The 
# command executes an external program and waits until it is finished running 
before continuing with other login script commands. 

This command fails when

The given directory is invalid

Proper security rights are lacking

The executable file cannot be found

Insufficient workstation memory is available to load the file

IMPORTANT: Use the @ command instead of the # command to run an external 
program from a login script if that external program will remain open for any length 
of time. Otherwise, the login script will remain open until that external program is 
closed. (Login scripts cannot be edited when they are held open.)
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Command Format

# [path] filename [parameter]

Replace path with a drive letter, or, if you have specified NOSWAP on the 
command line or in the login script, you can replace path with a full directory 
path beginning with the NetWare volume name.

Replace filename with an executable file (files that end in .EXE, .COM, or 
.BAT, for example). It isn’t necessary to include the extension, but doing so 
can speed up the execution of the external program.

Replace parameter with any parameters that must accompany the executable 
file.

Example

You can use Automatic Client Update (ACU) to update Novell Client software 
without having to physically visit each workstation and manually update the 
software.

ACU uses a text file that can be called from the login script. To call this file 
from the login script for a workstation running Novell Client for Windows 
NT/2000, place one of the following commands in the login script:

#Z:\PUBLIC\INSTALL\NTCLIENT\SETUPNW.EXE /ACU

or

#\\[SERVER]\[VOLUME]\PUBLIC\INSTALL\NTCLIENT\SETUPNW.EXE 
/ACU

@

Use the @ command to execute a program that is external to the login script 
and then continue with the script (similar to the Startup group). Enter the @ 
command followed by the name of the file that you want to execute.

IMPORTANT: Use the @ command instead of the # command to run an external 
program from a login script if that external program will remain open for any length 
of time. Otherwise, the login script will remain open until that external program is 
closed. (Login scripts cannot be edited when they are held open.)

This command fails when

The given directory is invalid

Proper security rights are lacking
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The executable file cannot be found

Insufficient workstation memory is available to load the file

Command Format

@ [path] filename [parameter]

Replace path with a drive letter.

Replace filename with an executable file (files that end in .EXE, .COM, or 
.BAT, for example). Do not include the extension.

Replace parameter with any parameters that must accompany the executable 
file.

Examples

If you want to start the GroupWise® program from within the login script, you 
must have a search drive mapped to where the GroupWise application is 
stored. Enter the following command in the login script:

@GRPWISE5

You do not need to enter a path in this case, because the executable program 
file for GroupWise 5 (GRPWISE5.EXE) is located in a search drive.

If you do not have a search drive mapped to the directory where the program 
is located, include the path to that directory in the command. For example, if 
the program to run GroupWise 5 is located in the APPS directory on drive G, 
use the following command:

@SYS:\APPS\GRPWISE5

ATTACH

Establishes a connection between a workstation and a NetWare server. If the 
server is not in the current tree, a bindery connection is made.

In networks running NetWare 3 or earlier versions, use the ATTACH 
command to connect to multiple file servers. In NetWare 4.x and NetWare 5, 
users no longer need to attach separately to multiple servers and do not need 
to use the ATTACH command. If users want to connect to multiple trees, use 
the TREE command (see “TREE” on page 88).

IMPORTANT: If users are trying to create persistent drive mappings, use the MAP 
command (see “MAP” on page 78).
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BREAK

Use BREAK ON to allow the user to terminate execution of the login script. 
The default is BREAK OFF. If BREAK ON is included in a login script, the 
user can press Ctrl+C or Ctrl+Break to abort the normal execution of the login 
script. 

NOTE: When the BREAK option is ON, type-ahead keyboard input is not saved to 
the buffer.

Command Format

BREAK ON|OFF

CONTEXT

Use CONTEXT to set a user’s current context in the NDS tree. Similar to the 
CX utility in DOS, you can enter a complete name to move down through the 
context, or you can use periods to move up toward the root of the tree. 
However, CONTEXT does not support all options that the CX workstation 
utility does; CONTEXT only sets the context.

Command Format

CONTEXT context

To change the current NDS context, replace context with the context that you 
want the user to see after login.

Example

To change the context to the Organizational Unit SALES, under the 
Organization NOVELL_US, add the following line to the login script:

CONTEXT .SALES.NOVELL_US

You can type a single period instead of a container name to indicate that you 
want to move up one level.

For example, if you are in the context SALES.NOVELL_US and you want to 
move up one level to the context NOVELL_US, add the following line to the 
login script.

CONTEXT .

To move up two levels, enter two periods, etc.
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DISPLAY

Use DISPLAY to show the contents of a text file when the user logs in.

When you use DISPLAY, all characters in the file, including any printer and 
word processing codes, appear. This command works best with an ASCII file. 

To display only the text and suppress codes, use “FDISPLAY” on page 70.

NOTE: If the given path does not exist or if the file is not found, no error message 
appears on the screen when the user logs in.

Command Format

DISPLAY [path] filename

Replace path with either a drive letter or a full directory path beginning with 
the NetWare volume name.

Replace filename with the complete name (including the extension) of the file 
that you want to display.

Example

Suppose you put messages in a file called SYSNEW.TXT in the 
SYS:PUBLIC\MESSAGES directory, and you want your users to see the 
messages when they log in on Monday. Add the following lines to the 
container login script:

IF DAY_OF_WEEK="Monday" THEN

DISPLAY SYS:PUBLIC\MESSAGES\SYSNEWS.TXT

END

DRIVE

Use DRIVE to change the default drive while the login script is executing.

If this command is not included in the login script, the default drive will be set 
to the first network drive, which is often assigned to the user’s home directory 
upon login.

If you don’t want the default drive to be the first network drive, map a drive 
in the login script to the directory you want to be the default; then use the 
DRIVE command to change the default drive.
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Instead of specifying a drive letter such as F: or G:, you can use an asterisk 
followed by a number n to represent the nth network drive (for example, *3). 
This allows drive letters to reorder themselves automatically if previous drive 
mappings are deleted or added.

Command Format

DRIVE [drive |*n]

Replace drive with a local or network drive letter, or replace n with a drive 
number. The use of either is dependent on their already being assigned within 
the login script.

Example

Suppose a user will be working on only one project for several days and the 
files for that project are located on drive S:. Use the DRIVE command to set 
the default drive to S: so that the user doesn’t have to change the default drive 
manually after each login.

First, make sure drive S: is mapped to the correct directory in the user’s login 
script. Then enter the following command in the login script:

DRIVE S:

EXIT

Use EXIT to terminate execution of the login script. 

IMPORTANT: You cannot use EXIT in a login script to stop the login script and 
execute a program. EXIT only terminates the execution of the login script. If you 
want to execute a program after exiting the login script, you must use two 
commands: “#” on page 65 or “@” on page 66 followed on the next line by EXIT.

FDISPLAY

Use FDISPLAY to show the text of a word processing file when the user logs 
in.

To display both the text and the printer and word processing codes of a file, or 
to display an ASCII file, see “DISPLAY” on page 69.

When you use FDISPLAY to display a word processing file, the text is filtered 
and formatted so that only the text is displayed. FDISPLAY will not display 
tabs.
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NOTE: If the given path does not exist or if the file is not found, no error message 
appears on the screen when the user logs in.

Command Format

FDISPLAY [path] filename

Replace path with either a drive letter or a full directory path beginning with 
the NetWare volume name.

Replace filename with the complete name (including the extension) of the file 
that you want to display.

Examples

Suppose you put messages in a file called SYSNEWS.TXT in the 
SYS:PUBLIC\MESSAGES directory, and you want your users to see this file 
on their screens when they log in on Monday.

Add the following lines to the container login script:

IF DAY_OF_WEEK="Monday" THEN

FDISPLAY SYS:PUBLIC\MESSAGES\SYSNEWS.TXT

END

FIRE or FIRE PHASERS

FIRE or FIRE PHASERS emits a phaser sound by playing the 
PHASERS.WAV sound file.

Use this command to generate the phaser sound whenever a user logs in. Use 
FIRE or FIRE PHASERS with the IF...THEN command to make the sound 
execute a different number of times depending on the circumstances of the 
login.

Command Format

FIRE n soundfile

Replace n with the number of times that you want this sound to occur.

Replace soundfile with the name of the sound file that you want to play when 
this command is executed. (The sound file variable cannot be used on DOS 
workstations.) You can use any .WAV or platform-compatible sound file.
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Examples

The following line executes the phaser sound four times upon login:

FIRE 4

The following line executes the rifle sound three times upon login:

FIRE 3 RIFLE.WAV

To use a variable as the number of times to fire, use % before the variable, as 
follows:

FIRE %variable

For more information about using variables, see “Using Identifier Variables” 
on page 60.

GOTO

Use GOTO to execute a portion of the login script out of the regular sequence.

Set BREAK ON in your login script before experimenting with GOTO loops 
so that you can break out of a login script if necessary. See “BREAK” on page 
68.

IMPORTANT: Do not use GOTO to enter or exit a nested “IF...THEN” on page 73 
statement. This usage causes problems for the program.

Command Format

GOTO label

Use label to indicate where the login script should continue executing.

Example

To execute a loop of commands, include the following lines in the login script. 
In this case, the commands to be executed are labeled AGAIN (as indicated in 
the second line).

SET X="1"

AGAIN:

SET X=<X> + "1"

;see compound strings for this

WRITE <X>

IF <X> < "9" THEN GOTO AGAIN
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The GOTO command looks at the value of <X> (a DOS environment 
variable). If the value of <X> is less than 9, then <X> increments by 1 and 
GOTO loops back to the AGAIN label. When <X> gains the value of 9, the 
IF...THEN test becomes false, the GOTO is ignored, and the script continues 
normally.

IF...THEN

Use IF...THEN to perform an action only under certain conditions.

An example of a conditional statement is

IF MEMBER OF "CLERKS"

In this statement, some action is performed if the user who logged in belongs 
to the Group object named CLERKS.

The following is a different type of conditional statement:

IF DAY_OF_WEEK="MONDAY"

In this statement, the equal sign (=) indicates the relationship between the 
variable (DAY_OF_WEEK) and its value (Monday). Note that the value 
(Monday) is inside quotation marks.

When using IF...THEN statements, be aware of the following syntax rules:

Use AND or OR to include two or more conditionals in an IF...THEN 
statement.

Values of conditional statements must be enclosed in quotation marks.

Values of conditional statements are compared with the assumption that 
the values are characters, not numeric values. The value of 21, therefore, 
would be considered greater than the value of 100 when comparing these 
two characters. To ensure the system properly calculates numeric values 
instead of character values, use the VALUE modifier in the IF...THEN 
statement.

The ELSE statement is optional.

IF, ELSE, and END must be on separate lines. THEN does not need to be 
on a separate line.

If you include a WRITE command as part of the IF...THEN command, the 
WRITE command must be on a separate line.
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IF...THEN statements can be nested (up to 10 levels). However, GOTO 
should not be used in a nested IF...THEN statement to enter or exit from 
the body of an IF...THEN statement.

If your IF...THEN statement consists of only one line, you do not need to 
include END even if that line wraps. If your IF...THEN statement must be 
on more than one line (for example, if you used ELSE or WRITE, which 
must be on separate lines), you must include END.

Six relationships are possible between the elements of an IF...THEN 
statement. Represent these relationships with the following symbols:

=    Equals

< > Does not equal

>    Is greater than

>=  Is greater than or equal to

<    Is less than

<=  Is less than or equal to

Command Format

IF conditional [AND|OR [conditional]] THEN

commands

[ELSE

command]

[END]

Replace conditional with identifier variables. For information about identifier 
variables, see “Using Identifier Variables” on page 60.

Replace commands with any login script commands that you want to be 
executed if the specified condition is true.

Examples

If you place the following command in a login script, the message “Status 
report is due today” appears when the user logs in on Monday and “Have a 
nice day!” on other days:

IF DAY_OF_WEEK="MONDAY" THEN 
   WRITE "Status report is due today."  
ELSE 
   WRITE "Have a nice day!" 
END
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The following lines mean “If the hour (on a 24-hour scale) is greater than or 
equal to 12, then write ‘afternoon’”:

IF VALUE HOUR24>="12" THEN 
   WRITE "afternoon" 
END

The following command executes the CAPTURE utility on the fourth day of 
the week (Wednesday):

IF NDAY_OF_WEEK="4" THEN 
   #CAPTURE Q=FAST_Q NB TI=10 NFF 
END

The following example shows nested IF...THEN statements. Notice that there 
are two IF statements, so each one must have its own END statement:

IF DAY_OF_WEEK="MONDAY" THEN 
   MAP *6:=VOL1:APPL\WP 
   IF MEMBER OF CLERKS THEN 
      WRITE "Your report is due immediately!" 
   END 
END

Conditionals can be joined with commas, the word AND, or the word OR to 
form compound conditionals.

The first line of the following IF...THEN statement is a compound conditional 
that means “If it is the evening of the first day of the month”:

IF GREETING_TIME="EVENING" AND DAY="01" THEN 
   WRITE "The system will be backed up tonight." 
END

The following line is a compound conditional that means “If it is 11:59:59 
p.m.”:

An IF...THEN statement can include several commands that must be executed 
if the conditional is true.

The following example shows two commands that are executed on Tuesdays: 
a WRITE command that displays a message about a staff meeting, and an 
INCLUDE command that tells the login script to process any commands or 
messages contained in the file SYS:PUBLIC\UPDATE.TXT.

IF DAY_OF_WEEK="TUESDAY" THEN 
   WRITE "Staff meeting today at 10 a.m." 
   INCLUDE SYS:PUBLIC\UPDATE.TXT 
END
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INCLUDE

Use INCLUDE to execute independent files or another object’s login script as 
a part of the login script currently being processed.

These subscripts can be text files that contain valid login script commands 
(any of the commands explained in this section) or login scripts that belong to 
a different object you have rights to.

Text files that contain login script commands, as well as other objects’ login 
scripts, can be used as subscripts. Use these subscripts to supplement the main 
login script.

You can create and edit text file subscripts using any text editor. Subscripts do 
not need to have any particular filenames or extensions.

The INCLUDE command executes the login script commands contained in 
the subscript. It does not display the text of the subscripts.

INCLUDE nesting is limited only by available memory. This means that one 
subscript file can include another subscript file, which can include yet another 
subscript file, etc. In DOS, however, the maximum number of subscript files 
that you can nest is 10.

If the subscript is a text file, users must have at least File Scan and Read rights 
to the directory containing the subscript.

If you are using another object’s login script as a subscript, users must have 
the Browse right to the object whose script you are including and the Read 
right to the object’s Login Script property.

Command Format

INCLUDE [path]filename

or

INCLUDE object_name

To use a text file as a subscript, replace path with either a drive letter or a full 
directory path beginning with the NetWare volume name.

Replace filename with the complete name (including the extension) of the text 
file.

To execute another object’s login script as part of a login script, replace 
object_name with the name of the object whose login script you want to use.
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Examples

To execute a text file called SCRIPT.NEW (located in volume VOL1) as a 
subscript, add the following line to your main login script:

INCLUDE VOL1:ADMIN\USERS\SCRIPT.NEW

Suppose you are creating a container login script for all users under the 
Organizational Unit object SALES_LA. You recently created a container 
login script for users under the Organizational Unit object SALES_PV.

You’ve decided that the SALES_LA users could use the same login script as 
the SALES_PV users, but with a few more drive mappings.

In the SALES_LA login script, you could add the additional drive mappings, 
and then use the INCLUDE command to execute the entire SALES_PV login 
script as a part of the SALES_LA login script, as follows:

1. Create an alias for the SALES_PV Organizational Unit in the 
SALES_LA Organizational Unit.

2. Add this line to the SALES_LA Organizational Unit’s login script:

INCLUDE .SALES_PV_ALIAS.SALES.NOVELL_US

The following figure illustrates how the INCLUDE command executes the 
SALES_PV login script as part of the SALES_LA login script. 
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LASTLOGINTIME

Use LASTLOGINTIME variable to display the last time the user logged in.

If you include this command in the login script, the time of the last login is 
displayed on the workstation screen.

Command Format

LASTLOGINTIME

MAP

Use MAP to map drives and search drives to network directories or to map to 
NDS objects such as cluster-enabled volumes.

If you use MAP to automate drive map assignments during execution of the 
login script, users don’t need to map drives every time they log in.

If you do not want the result of each mapping to be displayed as it is executed, 
add the MAP DISPLAY OFF command at the beginning of the login script. 
When all drive map assignments have been completed, add the line MAP 
DISPLAY ON and MAP to your login script. This sequence provides a cleaner 
display for users as they log in.

Instead of specifying drive letters such as F: or G:, you could use an asterisk 
followed by a number n to represent the nth network drive. For example, if the 
first network drive is F: then using MAP *3:= would assign H: {1 2 3 = F G 
H}. Or, if the first network drive is D:, then using MAP *4:= would assign G: 
{1 2 3 4 = D E F G}.

This allows drive letters to reorder themselves automatically when local 
drives are removed or added or when the first network drive is changed. This 
also allows users to log in from workstations with a different number of local 
drives than their regular workstation.

You can map a local drive (usually A: through C:) to a network directory, but 
you cannot access the local drive until you remove the network drive mapping. 
Do not map over the local drive containing the Windows directory.

Do not map a drive to a network drive such as a CD-ROM drive.
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Command Format

MAP [[options]|[parameters][drive:=path]

Replace drive with any valid network drive letter, local drive letter, or search 
drive number.

Replace path with either a drive letter, a full directory path, a Directory Map 
object, or an NDS object such as a cluster-enabled volume.

More than one command can be on the map line if the commands are separated 
by a semicolon ( ; ), as shown in the following example:

MAP *1:=SYS:PUBLIC;*2:=SYS:PUBLIC\DOS

When mapping a drive to a directory on an NDS server, begin the path with 
either the Volume object name or server\volume.

When mapping to a directory on a bindery-based server or to an NDS server 
that isn’t the current server, begin the path with the server’s name.

When mapping to an NDS object, use the object’s fully distinguised name 
preceeded by a leading period (.).

Replace option with one of the following:

DISPLAY ON|OFF: Determines whether drive mappings are displayed 
on the screen when the user logs in. The default setting is ON. This option 
is valid only in login scripts.

ERRORS ON|OFF: Determines whether MAP error messages are 
displayed when the user logs in. MAP ERROR OFF must be placed 
before MAP commands in the login script. The default setting is ON. This 
option is valid only in login scripts.

Replace parameter with one of the following:

INS: Inserts a drive mapping between existing search mappings. 

DEL: Deletes a drive mapping, making that drive letter available for other 
mapping assignments.

ROOT or R: Maps a fake root. Windows NT* and Windows 2000 are 
always mapped to the root. Some applications require their executable 
files to be located in a root directory.

Since you might not want users to have rights at the root directory, you 
can map a fake root to a subdirectory instead. 
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The Windows NT/2000 native environment forces a map root on all 
drives. To prevent a forced map root in a Windows NT/2000 
environment, set the MAP ROOT OFF = 1 environment variable. All 
drives are then mapped as specified, and only explicit map root drives are 
rooted.

C (CHANGE): Changes a search drive mapping to a regular mapping, or 
a regular mapping to a search drive mapping.

P (PHYSICAL): Maps a drive to the physical volume of a server, rather 
than to the Volume object’s name.

A Volume object name might conflict with a physical volume name. (For 
example, object ACCT is an Accounting volume, but there is also a 
physical volume named ACCT.) Therefore, if you prefer to map a drive 
to the physical volume name, use MAP P.

N (NEXT): When used without specifying a drive number or letter, maps 
the next available drive.

NO_DEFAULT

Use NO_DEFAULT in a container or profile login script if you do not want 
the default user login script to run.

If you do not want to create any user login scripts and you do not want the 
default user login script to run, add this command to either the container or the 
profile login script.

NOTE: If you have created a user login script for a user, that login script executes 
whether or not the NO_DEFAULT command is in the container or profile login 
script.

Command Format

NO_DEFAULT
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PAUSE

Use PAUSE to create a pause in the execution of the login script.

You can add PAUSE to the login script following a message so that the user 
has time to read the message before it scrolls off the screen.

If you include PAUSE, the message “Strike any key when ready...” appears on 
the workstation screen. NetWare Login then waits for a key to be pressed 
before it executes the rest of the login script.

Command Format

PAUSE

PROFILE

Use PROFILE in a container script to set or override a user’s assigned or 
command line-specified profile script. This is useful when defining a group 
profile.

Command Format

PROFILE profile_object_name

Example

To override the profile script assigned to a user, and to cause the user to 
execute a PROFILE script called team_profile, use the following command:

PROFILE team_profile
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REMARK

To include explanatory text in the login script or to keep a line from being 
executed during testing, begin a line with REMARK, REM, an asterisk ( * ), 
or a semicolon ( ; ). Any text that follows these symbols is ignored when 
NetWare Login executes the login script. Remarks do not appear on the 
screen.

IMPORTANT: This command and its associated text must be the only entry on a 
line. Placing remarks on the same line as other login script commands can cause 
errors.

If a remark is several lines long, begin each line with the remark keyword 
(REMARK, REM, an asterisk, or a semicolon).

Command Format

REM[ARK] [text]

or

* [text]

or

; [text]

Replace text with the comment you want to include in the login script.

Example

The following are examples of explanatory text that you might use with the 
REMARK command and its variants:

* This is Richard’s login script

; Mapped network drives follow:

REM The next mapping is a fake root.

REMARK This login script is for new users.
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SCRIPT_SERVER

NetWare 2 and NetWare 3 users can use SCRIPT_SERVER to set a home 
server where the bindery login script is read from.

SCRIPT_SERVER has no effect on NetWare 4 and later users.

Command Format

SCRIPT_SERVER server_name

SET

Use SET to set an environment variable to a specified value. 

When you use SET in a login script, you must enter quotation marks (" ") 
around values.

If a variable is set to a path that ends in a \", these two characters are 
interpreted as an embedded quote preceded by an escape character. To avoid 
this problem, use two backslashes before the ending double quotes (\\").

You do not need to include SET commands in login scripts. For example, you 
might decide place some SET commands in the workstation’s 
AUTOEXEC.BAT file. Where you use SET commands depends upon your 
individual needs.

This command does not work in a login script if the DOS workstation’s 
environment is too small. In this case, you should set the environment size in 
the CONFIG.SYS file.

After you use the SET command to set a value for an environment variable, 
you can use that variable in other login script commands.

To include an environment variable as an identifier variable in a command, 
enclose the name of the variable in angle brackets (for example, <emailuser>).

Command Format

[TEMP] SET name="value"

Replace name with an environment parameter that identifies the environment 
you want to change.
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Replace value with identifier variable substitutions. Values must be enclosed 
in quotation marks.

To change the environment for the login script, but not for the workstation 
itself after the login script has finished executing, use the optional keyword 
TEMP.

Examples

You can use SET to make a prompt display the current directory path (such as 
F:\HOME\MARY>), rather than just the drive letter. To do this, add the 
following line to the login script:

SET PROMPT="$P$G"

“$P” lists the current directory path and “$G” displays a “>” (greater than) 
character.

To set a path for a program called DAILY, which is in the REPORTS 
subdirectory under drive G:, you would add the following line:

SET PATH="G:\REPORTS\DAILY"

This sets the variable PATH to G:REPORTS\DAILY.

Setting the variable PATH in the login script removes any search drives 
previously assigned. Use SET PATH only before you map search drives. SET 
PATH also overwrites any paths set in the user’s AUTOEXEC.BAT file.

To display this path, you can include PATH as an identifier variable in a 
WRITE command by enclosing the variable (not the value) in angle brackets. 
For example, the following line displays “My path is G:\REPORTS\DAILY”:

WRITE "My path is ";<path>

To include an environment variable in a MAP command, precede the variable 
with a percent sign (%). For example, you could include the following lines in 
a login script to set and map a drive to the variable NWS:

SET NWS="C:\XYZ"

MAP S16:=%<NWS>
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SET_TIME

Use SET_TIME to set the workstation time equal to the time on the NetWare 
server that the workstation first connects to.

If you set SET_TIME to OFF in the login script, the workstation time does not 
update to the server’s time.

Command Format

SET_TIME ON|OFF

SHIFT

Use SHIFT to change the order in which %n variables are interpreted in the 
login script. SHIFT allows users to enter login parameters in any order. For 
more information on %n variables, see “Login Parameters with %n Variables” 
on page 63.

You can shift up to 10 login script variables from %0 to %9.

When users execute NetWare Login, they can include additional parameters. 
Each of these parameters is assigned a %n variable; in this way, the 
parameter’s real value can be substituted for the %n variable that appears in 
the login script.

In the login script, you can add SHIFT with a positive or negative number to 
move the variables in either direction. For example, SHIFT -3 moves each %n 
variable three positions to the right.

Command Format

SHIFT [n]

Replace n with the number of places that you want the variable to shift. The 
default is SHIFT 1.

Examples

When Mary logs in, she wants to access her word processing program, change 
the way it is set up, and map a drive to her work directory called ACCNTS.
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Mary also has a command in her login script to map a drive to her DATABASE 
directory, but she does not need it today. The commands in Mary’s login script 
are shown here.

:LOOP 
IF "%2"="WP" THEN 
   SET WP="\U-CML\B-10\D" 
   MAP S16:=SYS:APPL\WP\SETUP 
END 
IF "%2"="ACCNTS" THEN MAP G:=SYS:ACCNTS 
IF "%2"="DATABASE" THEN MAP S16:=SYS:APPL\DATABASE 
SHIFT 
IF "%2"<>"" THEN GOTO LOOP

(In the last line, “IF "%2" < >” is followed by closed quotation marks, which 
means “If %2 isn’t blank”.)

With these commands in her login script, and assuming a command line login, 
Mary can log in to the primary file server (named FS1) using her username, 
MARY, as follows:

LOGIN FS1\MARY WP ACCNTS

The parameters in Mary’s login command are given the following values:

%0=FS1

%1=MARY

%2=WP

%3=ACCNTS

Mary’s login script looks for %2, which is WP, and sets the word processing 
environment. Then the login script shifts the variables one to the left so that 
%2 now becomes ACCNTS. Upon executing the loop, the login script maps a 
drive to the ACCNTS directory.

Mary could also change the order of her login command without affecting the 
way her work environment is set up, as follows:

LOGIN MARY ACCNTS WP

The parameters in this login command are given the following values:

%0=FS1

%1=MARY

%2=ACCNTS

%3=WP
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In this case, Mary’s login script looks for %2, which is now ACCNTS. The 
login script maps a drive to the ACCNTS directory. Then the login script shifts 
the variables to the left so that %2 now becomes WP.

Upon executing the loop, the login script sets the word processing 
environment.

TERM

This command is normally used only for Application Launcher scripts, a 
component of ZENworks for Desktops.

You can use the TERM command in a login script to stop the login script and 
return an error code.

You can also use TERM in an IF...THEN statement, so that the login script 
stops and an error code is returned only if an IF statement is true (that is, a 
certain condition exists). If the IF statement is false (that is, a condition doesn’t 
exist), the login script skips the TERM command and continues executing.

Because TERM stops the login script, be sure to put this command either at 
the end of the login script or at a point within the script where you intend 
execution to stop. Do not nest the TERM command in the login script.

If you add TERM to a container login script, it prevents other profile or user 
login scripts from running. If you put TERM in a profile login script, it 
prevents the user login script from running.

Command Format

TERM nnn

Replace nnn with an error level. Any error level between 000 and 999 is valid.

Example

If you want the login script to exit and return an error code of 718, you can add 
the following statement to the login script:

TERM 718
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TREE

The TREE command can be used only with clients that support multiple NDS 
tree attachments.

Use TREE to attach to another NDS tree within the network and to access its 
resources.

The TREE command changes the “focus” of the login script so that all NDS 
object references in subsequent script commands (for drive mappings, print 
captures, etc.) apply to the NDS tree specified in the TREE command.

You can include multiple TREE commands within a login script, either to 
attach to additional trees or to switch the login script’s “focus” back to a tree 
that the user is already attached to.

Command Format

TREE tree_name[/complete_name[;password]]

Replace tree_name with the name of the NDS tree that you want the user to 
attach to.

Replace complete_name with the user’s complete name (Distinguished Name) 
for the NDS tree that the user is attaching to. The complete name establishes 
the user’s context in the tree. If you do not include the complete name, the user 
is prompted for a complete name when the TREE command is executed from 
the login script.

Replace password with the correct password for that user and tree. If the 
username and password are the same as the primary login username and 
password, you can omit the password and not be prompted for it.

IMPORTANT: Use caution when including passwords in a login script. It is more 
secure to eliminate the password. Then, at the point in the login script where the 
TREE command is executed, the user is prompted for the password.

Example

To attach the user with the complete name MRICHARD.ACME (whose 
password is BUTTERFLY) to an NDS tree named CORP, add the following 
line to the login script:

tree corp/.mrichard.acme;butterfly
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WRITE

Use WRITE to display messages on the workstation screen when a user logs 
in to the network. Text that you want to display must be enclosed in quotation 
marks (" ").

There are several ways to display variables in the text message. The way you 
enter the variable in the WRITE command determines the display format, as 
follows:

If you type the identifier variable as shown, with no special punctuation, 
only the variable is displayed on the screen.

If you enclose the identifier variable inside quotation marks, precede the 
variable with a percent sign (%) and type it in uppercase letters. This 
method is often used to combine regular text with an identifier variable, 
because both the text and the variable can be enclosed in the same 
quotation marks.

To join several text strings and identifier variables into a single display 
without enclosing the variables in quotation marks, use a semicolon 
between the text and the variables.

If you have several WRITE commands, each one appears on a separate 
line on the user’s workstation. However, if you put a semicolon at the end 
of all but the last WRITE commands, the commands all appear as one 
continuous sentence or paragraph (although they might wrap onto 
additional lines on the workstation’s screen).

Text strings can include the following special characters:

In addition to the semicolon, you can use other operators to form compound 
strings (in other words, to join text and identifier variables into one command). 
These operators are listed in the following table, in order of precedence:

Character Meaning

\r Causes a carriage return

\n Starts a new line of text

\" Displays a quotation mark on the screen

\7 Makes a beep sound
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Command Format

WRITE "[text][%identifier]" [;][identifier]

Replace text with the words you want to display on the screen.

Replace identifier with a variable you want to display, such as a user’s login 
name. See “Using Identifier Variables” on page 60 for a complete list of 
variables.

Examples

To display the message “Hello,” add the following line to the login script:

WRITE "Hello"

To display the user’s surname along with a greeting, add the identifier 
LAST_NAME to the command. To do this, either join the text and the 
identifier with a semicolon or include the variable in the quotation marks with 
the text.

Either of the following lines displays “Hello, Smith” when user Bob Smith 
logs in:

WRITE "Hello, ";%LAST_NAME

WRITE "Hello, %LAST_NAME"

To make a beep sound occur while the phrase “Good morning” appears on the 
screen, add the following line to the login script:

WRITE "Good %GREETING_TIME \7"

Operator Meaning

* / % Multiply, divide, modulos

+ - Add, subtract

>> << Shift left or right (1000 >> 3 becomes 1)
90 Novell Client for Windows

Novell Client for Windows
103-000159-001
August 29, 2001

Novell Confidential



Manual 99a38 July 17, 2001
B Sample Login Scripts

You can create login scripts from these sample login scripts using NetWare® 
Administrator. Using a sample login script can help reduce syntax errors, 
reducing the time it takes you to create your login scripts.

For more information on how to create login scripts, see “Creating Login 
Scripts from a Sample or Existing Login Script” on page 32.

IMPORTANT: You must modify these sample login scripts to match the server 
names, directory paths, and specifications of your own network.

Sample Container Login Script

The container login script should contain any information that applies to all 
users. By using some or all of the commands included in the following sample 
container login script, you might find it easier to plan and create your own 
container login scripts.

For more detailed information about each type of login script command, see 
“Login Script Commands and Variables” on page 57.

MAP DISPLAY OFF
MAP ERRORS OFF
MAP *1:=%HOME_DIRECTORY

IF "%1"="ADMIN"THEN MAP *1:SYS:SYSTEM

IF OS = "WIN95" THEN
   MAP P:=SYS:PUBLIC
ELSE
   MAP INS S1:=SYS:PUBLIC
   MAP INS S2:=SYS:PUBLIC\%MACHINE\%OS\%OS_VERSION
END
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IF OS = "WINNT" THEN
   MAP P:=SYS:USERS\%LOGIN_NAME\WINNT
   MAP INS S16:=SYS:APPS\WINAPPS\WINNT
   SET TEMP = "P:\USERS\%LOGIN_NAME\WINNT\TEMP"
END

MAP INS S16:=VOL1:APPL\LOTUS
MAP INS S16:=SYS:EMAIL
MAP M:=VOL1:SHARED
MAP N:=VOL1:MODEMS

MAP O=SYS:DOC

IF MEMBER OF "MANAGERS" THEN
   MAP *3:=VOL1:PROJECTS\REPORTS
END

Sample Profile Login Script

If you have groups of users with identical login script needs, you can create a 
Profile object and then create a login script for it. Then you can assign each 
user to be a member of that object.

The following sample login script shows an example of a profile login script 
you might create for users in the Profile object ACCOUNTING. This profile 
login script would execute after the container login script had executed.

For more detailed information about each type of login script command, see 
“Login Script Commands and Variables” on page 57.

MAP DISPLAY OFF
MAP ERRORS OFF
MAP INS S16:=VOL1:APPL\DB
MAP *5:=VOL1:ACCOUNTS\NEW
MAP *6:=VOL1:ACCOUNTS\RECORDS

@GRPWISE5
MAP DISPLAY ON
MAP
WRITE
IF DAY_OF_WEEK="FRIDAY" THEN
   WRITE "Weekly progress report is due today."
   FIRE 2
END
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Sample User Login Script

The following sample login script is an example of a login script created for 
user Mary. The user login script executes after the container and profile login 
scripts have executed. In addition, a user login script prevents the default login 
script from executing for this specific user.

Therefore, you should consider whether any commands in the default login 
script are necessary for setting the user’s environment. If so, determine 
whether those commands should be placed into one of the other login scripts 
(container, profile, or user).

For more detailed information about each type of login script command, see 
“Login Script Commands and Variables” on page 57.

MAP DISPLAY OFF
MAP ERRORS OFF
MAP *7:=VOL1:MARY\PROJECTS\RESEARCH
MAP *8:=VOL1:FORMS
REM Mary needs access to FORMS while she’s on the
REM troubleshooting team.
SET WP="/u-mjr/b-5"
SET USER="mrichard"
#SEND /A=N

Sample Default Login Script

The default login script executes the first time User object Admin logs in. It 
also executes for any users who do not have user login scripts.

You can’t modify the default login script because it is coded into the Novell 
Login utility. Instead, you can create container, profile, or user login scripts.

The following sample of the default login script lists its contents and lets you 
find out more information about each command in the default login script.

For more detailed information about each type of login script command, see 
“Login Script Commands and Variables” on page 57.

MAP DISPLAY OFF
MAP ERRORS OFF
MAP *1:=%FILE_SERVER\SYS:
MAP *1:=%FILE_SERVER\SYS:%LOGIN_NAME
IF "%LOGIN_NAME"="SUPERVIS" OR "%LOGIN_NAME"="ADMIN" THEN
MAP *1:=%FILE_SERVER\SYS:SYSTEM
MAP INS S1:=%FILE_SERVER\SYS:PUBLIC
MAP INS S2:=%FILE_SERVER\SYS:PUBLIC\%MACHINE\%OS\%OS_VERSION
MAP DISPLAY ON
MAP
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C Troubleshooting Issues

This appendix provides troubleshooting information for known issues.

HINT: If you do not find a solution to your issue here, check the Readme file that 
accompanied the software as well as the Novell® Support Connection® information 
database (http://www.support.novell.com).

Windows 95/98 Issues

The following issues will help you troubleshoot Novell ClientTM for 
Windows* 95/98. For additional issues, check the Readme file, 
READ95.TXT, included with the software.

Installation

Drag-and-Drop Operations Do Not Work Immediately After Installation

Drag-and-drop operations between applications on the desktop might not 
work immediately after the client is installed and the workstation is rebooted. 
To solve this problem, reboot again to ensure proper registration of the 
ActiveX* controls included in the client.

IP with IPX Compatibility Dependency

When using the IP with IPXTM Compatibility client configuration, make sure 
that the TCP/IP stack has been configured with a TCP/IP gateway. This can be 
configured through DHCP or defined locally. The IPX Compatibility driver 
and IP routing will not work properly without a TCP/IP gateway configured. 
Under Windows 95/98, the gateway can be configured by opening the TCP/IP 
Properties page from the Network Properties page. If your network is 
configured to use DHCP, you do not need to configure the gateway locally.
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IP with IPX Compatibility Needs Migration Agent

If you are using the IP with IPX Compatibility configuration on the client and 
are trying to connect to servers running IPX only, make sure that you have 
configured a Migration Agent (MA) on the network.

For more information on setting up a Migration Agent on the network, see the 
NetWare® 5 documentation. To troubleshoot a NetWare client’s MA visibility 
or configuration, enter CMDINFO at the DOS prompt. This command should 
list all configured or discovered MAs, depending on the IPX compatibility 
configuration.

Dial-Up Networking

Dial-Up Networking Over IP: SLP Configuration

In order to use SLP name resolution with dial-up networking, you must add 
the directory agent’s IP address to the directory agent list on the Novell 
NetWare Client Properties Service Location tab. To do this:

1 Right-click the N icon in the system tray, then click Novell Client 
Properties.

2 Click the Service Location tab.

3 Add the directory agent IP address to the directory agent list, then click 
OK

Dial-Up Networking Over IP: Unable to See the Network

If you are using dial-up networking on the client and are unable to log in or 
browse the network:

1 Make sure that you can resolve NetWare 5 or later IP server names.

For dynamic discovery of servers, make sure that your client can locate 
an SLP Directory Agent. The agent can be configured statically or it can 
be configured through DHCP if your dial-up host supports DHCP and is 
configured with the proper Discovery Agent.

NOTE: By default, the client uses DHCP to locate a Discovery Agent. (This 
assumes that a Discovery Agent is configured on the dial-up host network.)

NOTE: The client uses an NWHOST file, if present, which contains server names 
and their addresses. This might be a preferred way to run your client. (The file is 
created in the NOVELL\CLIENT32 directory on the workstation.)
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The client also supports DNS names. After connecting to the dial-up host, make 
sure that your DNS server is working properly by attempting to ping your server 
using its DNS name. If the ping was successful, then use that same DNS name as 
your server name in the login dialog.

HINT: Isolate the problem down to name resolution by using an IP address 
instead of the server name. If the login works, the problem is in name resolution.

2 Make sure that the IP stack is still functioning properly by pinging known 
active IP nodes that are on the dial-up host network.

3 If you are using IP with Compatibility Mode on the client and cannot see 
any IPX servers, make sure that the clients Migration Agent is configured 
properly. See “Dial-Up Networking with Compatibility Mode” on page 
97.

Dial-Up Networking with Compatibility Mode

In order to use Compatibility Mode to locate IPX services over a dial-up 
connection, you should statically configure the Migration Agent on the 
Compatibility Mode Driver property page.

NOTE: If your dial-up host supports DHCP Inform requests and is configured to 
hand out Migration Agents, you shouldn’t need to set the Migration Agent statically.

To set the MA address statically:

1 Click Start > Settings > Control Panel.

2 Double-click Network > Compatibility Mode Driver (CMD)

3 Uncheck the Use DHCP check box and then add a Migration Agent, using 
an IP address in dotted format (for example: 137.65.1.5). You can also use 
a DNS name, keeping in mind the dial-up environment that you are using.

4 Press OK to save the changes.

Printing

Do Not Configure a Local NPRINTER with Interupts

Do not configure a local NPRINTER with interrupts. Use the default “polled 
mode” instead.
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Windows NT/2000 Issues

The following issues will help you troubleshoot Novell Client for Windows 
NT/2000. For additional issues, check the Readme file, WINNT.TXT, 
included with the software.

Installation

IPX Compatibility Mode and the IPX Internal Network Number

Workstations using IPX Compatibility Mode cannot have an IPX internal 
network number configured. If you have configured an IPX internal network 
number on your workstation and you plan to install the Novell IP Client with 
IPX Compatibility Mode, then remove the IPX internal network number 
before installing the client.

Errors Resulting From a Custom Installation of Novell Client for Windows NT

We recommend that you use the Typical Installation option for most 
installations of Novell Client software. If you are installing Novell Client and 
you select Custom Installation, note that the Novell IP gateway is not 
compatible with NetWare IP or CMD (IPX Compatibility Mode Driver).

Using Remote Management with ZENworks for Desktops Full

If you plan to use Remote Management, make sure that Workstation Manager 
is installed on all workstations that will be managed remotely and that you are 
running the full version of ZENworksTM. Remote Management is not 
compatible with the IP gateway.

TCP/IP Source Path Parameter for Unattended Installation

The TCP/IP Source Path parameter has been added to the unattended network 
installation. This parameter is not included in Novell Client Install Manager. 
To use this parameter, you must add it manually to the UNATTEND.TXT file.

!TCPIP_SOURCE_PATH = path

This parameter is used with Automatic Client Upgrade (ACU) to upgrade an 
IP client. Specify the full path to the source files for the Microsoft* TCP/IP 
installation files. If this parameter is not specified, the location where the ACU 
was run from will be used as the default.
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Additionally, all parameters to configure TCP/IP are available as well. These 
are the same parameter names that are specified by Microsoft for use during 
an unattended operating system install. They should be added under the 
Novell Client section of the unattend file. For more information on unatteded 
network installations, see “Installing Clients from the Network” on page 19.

Password Issues

We recommend that administrators configure NT workstations to not use any 
of the Microsoft password restrictions available in User Manager. Novell 
Client for Windows NT/2000 works best if password restrictions are left up to 
NDS.

Login Script Issues

CAPTURE Execution in a Login Script

If you use a login script that contains an external CAPTURE command using 
CAPTURE.EXE, the screen might go blank with a blinking cursor in the 
upper-left corner. The capture eventually executes and the screen returns to 
normal.

This happens if Windows NT* or Windows 2000 is set to “full screen” when 
the CAPTURE command is executed from the login script. Although the 
system may be working correctly, a slow server performing the capture with a 
blank screen may make it appear otherwise.

To correct this problem:

1 Double-click My Computer > Control Panel > MS-DOS Console.

2 In the Console Windows Properties dialog box, select the Options tab.

3 From the Display Options group, click Window.

Login Script Command SET_TIME ON/OFF Behaves Differently on NT

Novell Client for Windows NT/2000 Properties > Advanced Settings contains 
a Set Station Time property.

When this setting is On, the workstation time is always synchronized with the 
network during GINA Login. The Login script SET_TIME command has no 
effect on time synchronization, because the time is being synchronized before 
the script command is processed.
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When the setting is Off, the “SET_TIME ON” script command will have an 
effect when scripts are run, and the workstation time will be synchronized 
with the network.

MAP.EXE

The MAP.EXE utility might function improperly if the computer’s DOS 
environment size is too small. If you encounter problems while running 
MAP.EXE, increase the DOS environment size by adding or editing the 
“SHELL=” line in the WINNT\SYSTEM32\CONFIG.NT file. For example:

SHELL=%SYSTEMROOT%\SYSTEM32\COMMAND.COM /E:2048

MAP.EXE was not designed as a Windows NT/2000 executable and, 
therefore, does not recognize drives mapped to NT servers as network drives. 
Consequently, MAP will not list NT network drives. The Windows NT NET 
USE command can be used to correctly connect and list network drives for 
both NetWare and NT servers.

Drive Mappings Automatically Root Mapped

In Windows NT/2000, all drive mappings made using the NetWare Login are 
root mapped. Because of this, programs cannot access directories above the 
directory that the drive is mapped to. This feature only affects MAP 
commands performed in a login script. Once Windows NT has been started, 
NT allows you to only map to the root.

You can turn off the default by adding SET MAPROOTOFF="1" as the first 
line in the login script. This will globally force all NT workstations using the 
login script to not map root drives.

Or, you can perform the following procedure on a local workstation.

1 Right-click My Computer.

2 Click Properties > Environment.

3 Enter MAPROOTOFF as a variable.

4 Set the value of the MAPROOTOFF variable to 1.

5 Click Select.
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Remote Access Services Issues

Supporting a Large Number of Remote Access Services (RAS) Users

If you support a large number of RAS users in your network and you 
experience problems with users not being able to log in because of insufficient 
NetWare connections, try setting the Watchdog configuration parameters so 
that connections time out quickly when RAS connections terminate 
abnormally.

SLP Requirements for Server Name Resolution from RAS Clients

If you rely on SLP to provide the resolution of server names to IP addresses in 
your network and your RAS server does not forward IP multicast packets 
between the client and the network, then you must set up and configure SLP 
Directory Agents.

You can configure SLP Directory Agents through the Novell Client property 
pages or through DHCP.

IPX Compatibility Requirements for RAS Client

IPX Compatibility Mode requires the services of SLP. For more information, 
see “SLP Requirements for Server Name Resolution from RAS Clients” on 
page 101.

Before installing the Novell IP Client with IPX Compatibility support, make 
sure that the RAS Client is configured to perform only IP networking over the 
RAS connections.

Restoring RAS Connections and IPX Compatibility

You must restart your workstation before reestablishing a RAS connection if: 

The RAS server assigns your client a different IP address during each 
RAS connection

You are using IPX Compatibility Mode to run IPX applications or to 
connect to IPX servers from your Novell IP Client

You can avoid the changing address problem over RAS connections if you 
statically configure the IP address that your workstation uses over the dial-up 
adapter.
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Software Compatibility Issues

Microsoft SMB Client Support over IPX

Novell Client for Windows NT/2000 coexists with the Microsoft SMB Client 
over IPX networks. The Microsoft SMB Client utilizes NetBIOS when 
communicating over IPX, which increases the utilization of your network.

If you want to prevent the Microsoft SMB Client from communicating over 
NetBIOS, modify your workstation configuration by unbinding the 
workstation and server from NWLink NetBIOS in the Network Properties 
page.
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